How to Use Pulse

The Pulse website is one of the tools provided by R+F to help you establish and grow your business. Specifically, you use Pulse to:

- Gauge current performance
- Analyze business results
- Develop your business
- Communicate with your business
- Generate leads
- Manage leads
- Viewing order history

When you log in to Pulse, the first thing you see is your Dashboard. The Dashboard provides a navigation bar of tabs, the Pulse menu, a summary of your current performance, shortcuts to quickly navigate through Pulse and alerts.

Use the Pulse menu, which displays your name, to quickly find and use the Pulse features, launch your personal websites and logout of Pulse.
Pulse FAQs

The Pulse FAQ is organized around the following types of questions:

- General
- Technical
- Dashboard
- Alerts
- Performance Reports and Views
- Pulse Mobile
Pulse General Questions

What is Pulse?

Pulse is a state-of-the-art web-based business management system designed to help you gauge current performance, analyze business results, develop your business, communicate with your business, generate leads, manage leads and view order history.

What type of Pulse subscriptions are offered?

There are three types of Pulse subscriptions:

- Free 30-day Pulse Pro trial, available to new Consultants when they first enroll.
- Free Pulse, with a limited number of features.
- Pulse Pro, a paid subscription that provides the full range of Pulse features.

What are the features available with the Free Pulse subscription?

- Comms Corner (Available to US Consultants only)
- RF Payday (Available to US Consultants only)
- RF Connection
- RF Mail
- All Performance reports, except Vital Signs, RFx reports, Fast Start reports, and Promotions.
- Biz Dev Library
- Orders
- Events
- Getting Started
- Lead the Way

What are the features available with the paid Pulse Pro subscription?

All features provided with Free Pulse, with these additional features:

- RFSN Widget (Available to US Consultants only)
- Alerts
- Edit My PWS
- Contacts
- R+F business e-mail account (EComms)
- Vital Signs report
- RFx reports
- Fast Start reports
- Promotions reports
- .biz PWS
- .com PWS

How much does Pulse Pro cost?

The Pulse Pro monthly subscriptions costs are:

- CAD $19.95/month for Canadian Consultants.
- USD $24.95/month for US Consultants.

US Consultants receive 20 SV per month for their Pulse Pro subscription, which counts toward the monthly 100 SV requirement for commissions.

Is Pulse required?

It is recommended that you subscribe to Pulse to receive the full range of tools and features to develop and manage your R+F business. However, you are able to conduct your R+F business without purchasing Pulse Pro. You can use the Rodan + Fields corporate website to enroll Consultants and sell products online. If you do choose to conduct your business this way, it is imperative that all your Customers and Consultants identify you as their Sponsor, and that they log in to the site so that their purchases are attributed to your account.

How do I subscribe to Pulse?

New Consultants can subscribe to Pulse as part of the enrollment process. All Consultants can subscribe to Pulse Pro from Pulse.

Can I edit or cancel my Pulse subscription?

You can edit your Pulse subscription at any time. You can only cancel your Pulse subscription by contacting Sales Support at (415) 273-8000.

What is my Pulse login username and password?

Your Pulse username and password are the same as your R+F account username and password.

How do I log in to Pulse?

You can start and log in to Pulse in various ways: from the R+F Corporate website, from your PWS and from the Pulse website.
Can I change my Pulse username and password?
Yes, you can change your Pulse username and password.

Can I update my contact information?
Yes, you can change the contact information displayed on your PWS.

What is my Pulse email address?

Available to Pulse Pro subscribers only

Pulse Pro subscribers automatically receive a Rodan + Fields e-mail address. Your Pulse e-mail address is the first part of your PWS URL combined with @myrandf.com. For example, if your .biz PWS URL is http://janedoe.myrandf.biz, then your Rodan + Fields e-mail address would be janedoe@myrandf.com.

How often is the information on Pulse updated?
Most data in Pulse is updated in near real time. However, there may be some server delays in updating your information, such as a newly placed order or on high volume days like month end. To ensure that you are viewing the most up-to-date data, refresh your web page.

Can more than one person use a single Pulse account?
Yes, more than one person can access Pulse using the same account, at the same time. However, only one person at a time can make changes to the account. If you are sharing your Pulse account with another person, please be advised that Pulse contains privacy sensitive information, including your billing information.

Are there any technical or system requirements for Pulse?
Pulse requires an Internet connection and a Web browser. Pulse runs on most operating systems (including Macs) and Web browsers. Please contact Pulse Technical Support if you experience any technical issues accessing the site on your computer.

Can I get Pulse on my smart phone?
Yes, you can access Pulse on any smart phone, tablet and other web-enabled devices. Note that Pulse is optimized for web browsers on a computer, so some features may not be completely compatible with these other devices.

What types of Pulse support are available?
Pulse have several types of available support:

- Video tutorials. Short videos available from the Pulse Biz Dev Library illustrate how to use specific Pulse features.
- Pulse documentation. Refer to Using Pulse, available from the Pulse Biz Dev Library.
- Sales Support. As always, your Sales Support Team stands ready to support you at 1-415-273-8000 during published business hours.
Pulse Technical Questions

Can I access Pulse from my smart phone, such as an iPhone or Android?
Yes, you can access Pulse on any smart phone, tablet and other web-enabled devices. Note that Pulse is optimized for web browsers on a computer, so some features may not be completely compatible with these other devices.

Can I forward my Pulse email to another account?
No, you can only access your Pulse e-mail online through Pulse.

Which browsers can I use with Pulse?
Pulse works on all browsers. If you have any technical difficulties accessing Pulse on your computer, please contact Sales Support at (415) 273-8000.

Are there any technical or system requirements for Pulse?
Pulse requires an Internet connection and a web browser. Pulse runs on most operating systems (including Macs), web browsers and other web-enabled devices such as smart phones and tablets.

Are there any other technical requirements for Pulse?
Pulse uses pop-ups for various features, including alerts and reports. To optimize your Pulse experience, you need to disable any pop-up blockers.

Can I synchronize my Events calendar or Contacts with my mobile phone?
No, synchronization is not available with this version of Pulse.

Can more than one person use a single Pulse account?
Yes, more than one person can access Pulse using the same account, at the same time. However, only one person at a time can make changes to the account. If you are sharing your Pulse account with another person, please be advised that Pulse contains private sensitive information, including your billing and downline contact information. Individuals not on your Rodan + Fields account should not be given access to Pulse.

Will Pulse run on a Mac?
Yes.

My data on Pulse is not updating, what should I do?
Most data in Pulse is updated in near real time. However, there may be delays (up to 1 hour) in updating your information, such as when a new order is placed. On high volume days, like month end, updates may take longer.
Pulse Dashboard Questions

- **What is a Dashboard?**
  When you log in to Pulse, the first thing you see is your Dashboard. The Dashboard provides a navigation bar of tabs, summary of your current performance, shortcuts to quickly navigate through Pulse, and alerts.

- **What is my business inspiration?**
  The Pulse Dashboard displays a default quote as a reminder of the reason you are building your R+F business. It is what keeps you moving forward despite the obstacles and roadblocks that are bound to arise on your journey to success.

- **How do I change my business inspiration?**
  You can personalize the business inspiration that appears on the Pulse Dashboard, and include a photo, to provide a more meaningful inspiration and motivation.

- **What do the various colors mean on my Sales Volume (SV) and PSQV graphs?**
  The colors green, yellow and red give you a quick indication of your current volume qualifications status. If your SV or PSQV graph shows green, it means that you've met your respective volume requirements. Yellow means that you have not currently met your volume requirements but will once the scheduled autoships are successfully processed. Red means that you will not meet your volume requirement for the month unless you acquire additional volume.

- **Why is my Sales Volume graph yellow?**
  Yellow indicates that although your current qualification SV is below 100, once your scheduled autoships process successfully, you will be at or above 100 SV. Since there is a chance that the scheduled autoship could fail, you should check back after your CRP date to make sure it processed successfully.

- **How does Pulse estimate my PSQV?**
  Clicking Estimate My PSQV on the My PSQV graph displays your estimated PSQV for the month if all scheduled autoships from your Personally Sponsored Preferred Customers and Personally Sponsored Consultants and their Retail Customers process successfully.

- **Why is my PSQV graph pointing to red?**
  Your PSQV for the month will be less than 600 (the amount need to maintain Executive Consultant status) unless you acquire additional PSQV.

- **What does the EC Leg Qualification graph show?**
  This graph shows how you are tracking toward maintaining your title or achieving a new milestone. As Executive Legs qualify throughout the month, the achievement bar moves up. Your goal is to meet or exceed your performance last month, indicated with the light blue fill line.

- **Are Gracing ECs in my personal team counted in the EC Leg Qualification graph?**
  If your personal team EC has satisfied their SV requirement, and is using an available Grace to qualify for the PSQV, that EC will count as an EC Leg for you starting on the 21st of the month. Additionally, any ECs in your personal team using an available Grace for their SV (and has satisfied their PSQV) will be counted if their Downline EC has qualified for the month.
Pulse Alerts Questions

Why I am seeing an urgent alert message when I log in to Pulse?
You are seeing an urgent alert message because you have one or more of the following volume qualification conditions:

- Your SV is below 100 after the 20th of the month.
- You are an EC+, and your PSQV is below 600 after the 20th of the month.
- Your personal CRP has failed.

How do I make the urgent alert message go away?
By acknowledging the message when you log in to Pulse. However, alerts are shown on your Dashboard and remain visible until the issue has been resolved or the month ends.

Will I see the urgent alert message each time I log in to Pulse?
No, once you have acknowledged the message, you will not see it again. However, new urgent alert messages will be displayed.

What are the type of Pulse alerts?
There are two type of Pulse alerts: urgent alerts and business alerts. Urgent alerts communicate critical information. These alerts require you to acknowledge the message when you log in to Pulse. After you acknowledge that you have urgent alerts, these alerts are shown at the top of your Dashboard in red, in addition to being listed in the Alerts area. Clicking on an alert provides the functionality or information needed to resolve the issue.

Business alerts are shown in the Alerts area. Clicking on an alert provides the functionality or information needed to resolve the issue.

Why is my Sales Volume graph yellow?
Yellow indicates that although your current qualification SV is below 100, once your scheduled autoships process successfully, you will be at or above 100 SV. Since there is a chance that the scheduled autoship could fail, you should check back after your CRP date to make sure it processed successfully.

How does Pulse estimate my PSQV?
Clicking Estimate My PSQV on the My PSQV graph displays your estimated PSQV for the month if all scheduled autoships from your Personally Sponsored Preferred Customers and Personally Sponsored Consultants and their Retail Customers process successfully.

Why is my PSQV graph pointing to red?
Your PSQV for the month will be less than 600 (the amount needed to maintain Executive Consultant status) unless you acquire additional PSQV.

What does the EC Leg Qualification graph show?
This graph shows how you are tracking toward maintaining your title or achieving a new milestone. As Executive Legs qualify throughout the month, the achievement bar moves up. Your goal is to meet or exceed your performance last month, indicated with the light blue fill line.

Are Gracing ECs in my Personal Team counted in the EC Leg Qualification graph?
If your Personal Team EC has satisfied their SV requirement, and is using an available Grace to qualify for the PSQV, that EC will count as an EC Leg for you starting on the 21st of the month. Additionally, any ECs in your Personal Team using an available Grace for their SV (and has satisfied their PSQV) will be counted if their Downline EC has qualified for the month.
Pulse Performance Reports and Views Questions

What reports are included from the Performance tab of Pulse?
- Flat Downline Tree View
- Vital Signs (available to Pulse Pro subscribers only)
- RFx Executive Consultants Report (available to Pulse Pro subscribers only)
- RFx Current Performance Report (available to Pulse Pro subscribers only)
- Fast Start - Team Development Bonus Report (available to Pulse Pro subscribers only)
- Fast Start - Team Advancement Bonus Report (available to Pulse Pro subscribers only)
- Promotions Report (available to Pulse Pro subscribers only)
- Autoship CRP/Pulse Report
- Autoship PC Perks Report
- PC Cancellations Report
- Downline Report
- Earnings Statement
- PSQV Report
- PEI Activity Report

What do the various colors mean on my Sales Volume (SV) and PSQV graphs?
The colors green, yellow and red give you a quick indication of your current volume qualifications status. If your SV or PSQV graph shows green, it means that you’ve met your respective volume requirements. Yellow means that you have not currently met your volume requirements but will once the scheduled autoships are successfully processed. Red means that you will not meet your volume requirement for the month unless you acquire additional volume.

What does the EC Leg Qualification graph show?
This graph shows how you are tracking toward maintaining your title or achieving a new milestone. As Executive Legs qualify throughout the month, the achievement bar moves up. Your goal is to meet or exceed your performance last month, indicated with the light blue fill line.

Are Gracing ECs in my Personal Team counted in the EC Leg Qualification graph?
If your Personal Team EC has satisfied their SV requirement, and is using an available Grace to qualify for the PSQV, that EC will count as an EC Leg for you starting on the 21st of the month. Additionally, any ECs in your Personal Team using an available Grace for their SV (and has satisfied their PSQV) will be counted if their Downline EC has qualified for the month.

What information is shown on the Road to RFx table?
The Road to RFx table shows your qualification towards achieving/maintaining the RFx title and Road to RFx Car Incentive Program.

What is L1 - L6 Volume?
Since your organization volume is constantly changing throughout the month as Executives promote and generations emerge, and that can't be shown in real-time, the L1 - L6 volume helps you gauge your performance. In most cases, your organization volume is at least the amount of your L1 - L6 volume.

How are L1 + L2 and L1 - L6 volume calculated?
These qualification volumes take any roll arounds in your organization into account, so that the calculation is the sum of commissionable volumes of your levels, with roll arounds.

Can I see my current organization volume in real-time?
No, since organization volume is constantly changing throughout the month as Executives promote and generations emerge, that can't be shown in real-time. Instead use L1 - L6 volume to help you gauge your performance. In most cases, your organization volume is at least the amount of your L1 - L6 volume.

Where can I see my grace period balance and next available grace period?
From the Flat Downline Tree view, click on your own name. The resulting Info Card shows your grace period related information.

Will my ECs that are using their grace period for their PSQV count as a qualified EC in the current month?
Yes, if your ECs are using their grace period to qualify for their PSQV (and have satisfied their SV), they will be counted and shown as qualified ECs for you in the month they are using the grace period, after the 20th of the month.

What filtering options are available on reports?
Depending on the report that you are viewing, you have a number of ways to filter a report.

Can I export report data to Excel?
Yes, you can export any of your Performance reports into Excel.

Can I export filtered reports?
Yes, only the filtered data is exported to Excel.

Can I see the roll arounds, and any pending roll arounds, in my organization?
Yes, use the Flat Downline Tree view.
Pulse Mobile Questions

Available to Pulse Pro subscribers only

What is the Pulse Mobile App?
The Pulse Mobile App is a complimentary iPhone app for Pulse Pro subscribers. It provides critical business information at your fingertips, including:

- **Alerts.** Notification for urgent and business alerts.
- **My Stats.** Up-to-date key performance indicators (KPIs), including SV and PSQV.
- **My Organization.** View and search your organization.
- **Fast Start and Orders.** Look up processed orders and view the Fast Start report.
- **Videos, R+F Headline News, R+F in the News, and Events.** Keep up with the latest R+F news, press mentions, and videos.
- **Quick Links.** Links to your PWS, the R+F Facebook page, the RF YouTube channel, Derm RF and more.

Is the Pulse Mobile App available to all consultants?
The Pulse Mobile App is available exclusively to Consultants subscribed to Pulse Pro (the paid version of Pulse).

How do I subscribe to Pulse?
New Consultants subscribe to Pulse during the Consultant enrollment process. Existing Consultants can subscribe to Pulse at any time by going to Pulse > My Account tab < Edit My Pulse Subscription link.

Does the Pulse Mobile App work on all mobile phones and tablets?
Currently the Pulse Mobile App is only available as an iPhone app. You can still access the full web version of Pulse on any smart phone, tablet (including the iPad) and other web-enabled devices.

How do I download the Pulse Mobile App?
You can download the Pulse Mobile App directly to your iPhone by going to the App Store and searching for "Rodan and Fields."

How much does the Pulse Mobile App cost?
Pulse Mobile is available as a free app for Consultants subscribed to Pulse Pro.

Once downloaded, how do I log in to the Pulse Mobile App?
Your Pulse Mobile App login information is the same username and password that you currently use for the web version of Pulse.

What is the Home screen?
The Home screen of the app is the main screen you see when you log in. It shows a menu of available sections.

How do I return to the Home screen from other sections of the app?
To return to the Home screen, click on the HOME button at the top-left corner of the screen.

Are alerts available in the Pulse Mobile app?
When you have new urgent and business alerts, you are notified of these alerts on the HOME screen. The number of new (unopened) alerts you currently have are displayed, in red, by the Alerts bar. Click on ALERTS to see the alerts. Once you have opened and reviewed an alert, the number of new (unopened) alerts on the HOME screen is updated. Note that urgent alerts continue to be displayed in Pulse web until you review those alerts using Pulse web.

What information is shown in MY STATS?
MY STATS shows your KPIs (Key Performance Indicators). The first screen shows your monthly qualification status for SV (Sales Volume) and PSQV (Personally Sponsored Qualifying Volume). The second screens illustrates your EC Leg qualifications. The last screen displays your progress on the Road to RFx. For more information on these KPIs, refer to the topic Gauging Current Performance.

Who is included in MY ORGANIZATION?
MY ORGANIZATION is similar to the Pulse Web Flat Downline Tree view, and shows your entire organization. Your L1 Downline is initially displayed; drill down by clicking on the Organization icon.

Can I see contact and performance information on my team members?
Yes, you can view contact and performance information by clicking on the name of an individual.

When viewing a team member's contact information, click the gray pull-down tab at the top of the screen to see all information for that individual. From this screen, you can click on their phone number or e-mail address to contact the individual directly from your phone.
How do I search for a team member?
To search your organization, click the SEARCH button on the bottom of the MY ORGANIZATION screen and then select the desired filter option.

Can I select multiple US states in my search query?
Yes. To filter your organization by team members in several states, click the STATE drop-down menu and select the desired states. Then click DONE. Make sure to click the SEARCH button to see the results.
What videos are available from the VIDEOS module?
Using the VIDEOS module, you can watch a variety of R+F videos directly from your phone, including the latest Skinpact News webisodes, the Doctors Business Introduction, select product videos, and the Week in Action webisodes.

To watch a video, you must have Internet access. Click on the video of interest; you are redirected to YouTube to watch the video. To return to the Pulse Mobile App, click on the iPhone Home button and then reopen the Pulse Mobile App.

Are the Fast Start and Order History reports the same as those available from Pulse Web?
Yes.

Can I view a Consultant's information from the FAST START screen?
Yes. To view contact and performance information about a Consultant, click on the row that contains the name of the Consultant of interest.

Can I view the past month's orders?
Yes. To view the past month's orders, select the desired month from the month selector at the bottom of the ORDERS screen.
How do I view order details?
Order details are displayed from the ORDERS screen. Click on the name of the individual of interest for their specific order details.

Is information on an order’s country of origin displayed?
Yes. The Order Detail screen includes information on the order’s country of origin.

Can I search or filter my orders?
Yes. You have the ability to filter order of a specified month by order type, date range, SV range and PSQV range.

Why is the text “no” and “incomplete results” shown when I filter orders by date range?
The date range option only filters within the month that your orders are shown. So if your date range is over several months, or is not set
within the month that you are viewing, the filter results are incomplete.

- **Am I logged in automatically to my account when I click on the PWS or Pulse links under QUICK LINKS?**
  No. For security reasons, you must log in to each site.

- **Is there a method to update my contact information or place/edit orders from the Pulse Mobile App?**
  No. All administrative and transactional tasks must be performed on the appropriate site.

- **What additional help is available on Pulse Mobile App?**
  For more information on the Pulse Mobile App, refer to the:
  - **Pulse Mobile Demo.** A short video demonstrating how to use select features.
  - **Using Pulse.** Provides information on Pulse Web features that are similar to features in the Pulse Mobile App.
  - **Sales Support.** Additional support is available from Sales Support during published business hours. Contact Sales Support by e-mail or by phone at 415-273-8000.
Pulse Basics

Before using Pulse, you should be aware of the following information on:

- System requirements
- Starting and quitting Pulse
- Subscribing to Pulse Pro
- Personalizing Pulse
- Creating an e-mail signature
- Pulse alerts
- Viewing R+F videos offline
- Clearing your cache
System Requirements

Pulse requires an Internet connection and a Web browser. Pulse runs on most operating systems and Web browsers.

Please contact Pulse Technical Support if you experience any technical issues accessing the site on your computer.
Starting and Quitting Pulse

You can start Pulse in various ways.

Quitting Pulse involves logging out of your current Pulse session.

Starting Pulse from the Corporate Website

1. Log in to the Company website.
2. Click Check My Pulse in the upper right corner of the page.

Pulse opens in the browser window.

Starting Pulse from your Personal Websites (PWS)

1. Log in to your PWS.
2. Click on the Check My Pulse link.

Pulse opens in a new browser window.

Starting and Logging in to the Pulse Website

1. Point your browser to the Pulse website.
2. Using the Sign In box, enter your Username and Password.
   Your Pulse username and password are the same as your R+F account username and password.

3. Click Sign In.
4. If you don't remember your password, click Forgot Password. Then check your e-mail for instructions on resetting your password.

Quitting Pulse

- From the Pulse menu, choose Logout.
Subscribing to Pulse Pro

A Pulse Pro subscription gives you access to the full functionality of Pulse, including the ability to:

- Have R+F Personal Websites (PWS)
- Personalize your PWS
- Receive urgent and business alerts
- Communicate with your business
- Generate leads
- Manage leads
- View the key performance indicators for all Consultants in your organization
- Identify your star performers
- Track the performance of your new Consultants
- Recognize your superstars
- Identify prospects
- Use the Pulse Mobile App for iPhone

To subscribe to Pulse Pro:

1. Click the **My Account** tab.
2. From the left panel, click **Edit My Pulse Subscription**.

You can also, from the My Account Overview page, click **Edit** from the Pulse Subscription section.

3. You are presented with the information and the ability to enroll.

**Note**: If the Subscription page doesn't open, make sure your pop-up blockers are disabled.
Personalizing Pulse

The Pulse Dashboard displays a default quote as a reminder of the reason you are building your R+F business. You can personalize this reason to provide a more meaningful inspiration and motivation, and include a photo.

Personalizing Your Business Inspiration

1. Place your cursor on the quote.
2. Click the Change Text button that appears.
3. Use the resulting text box to enter your inspirational text, and then click Save My "Why" Text.

Including a Photo on Your Dashboard

1. Place your cursor in the space to the left of the quote.
2. Click the Change Photo button that appears.
3. Use the resulting dialog box to locate and select the photo.
4. You are presented with a preview of how the photo will appear on your Dashboard, and the ability to crop or resize the photo. Then click Save Photo.
How to Create an E-mail Signature

Rodan + Fields® provides the ability to create different e-mail signatures for your:

- **Pulse e-mails**
- **Communications Corner custom marketing tools**

You can use the e-mail signature for Communications Corner also in Outlook. For Gmail, Yahoo Mail, and Hotmail, this e-mail signature can be used as a virtual business card.

Creating an E-mail Signature for Pulse E-mails

1. From the Pulse **Ecomms** tab, click **Signature**.

2. Use the **Edit Email Signature** window to create and style your signature, and then click **Save**.
   You cannot add a photo to your e-mail signature, however certain e-mail templates do incorporate the your PWS photo.

Creating an E-mail Signature for Communications Corner

1. From the Communications Corner website ([http://communications.rodanandfields.com](http://communications.rodanandfields.com)), select **E-mail Signatures**.
1. Select your e-mail signature design.
2. Customize your selected design with your contact information, and then click Next.
3. Download and save your design to your computer.

Using Your Comms Corner E-mail Signature in Outlook

1. From the Outlook File menu, choose Options.
2. Using the Outlook Options dialog box, select Mail.
3. Click the Signatures button.
4. From the Signatures and Stationery dialog box > E-mail Signature tab, click **New**.
4. Use the New Signature dialog box to specify the signature's name, and then click OK.

6. If you would like your signature automatically included in New messages and/or Replies/forwards, choose the signature from the drop-down menus.
7. Select the **Insert Image icon** and use the resulting dialog box to locate and upload the e-mail signature file that you created on Communications Corner. Then click **OK**.

   Note that due to Outlook image signature limitations, you may need to adjust sizing from within the e-mail. You can do this by clicking on the image and dragging it to the desired size.

---

**Using Your Comms Corner E-mail Signature as a Virtual Business Card**

1. Create a new e-mail.
2. Add as an attachment the e-mail signature file that you created on Communications Corner.
Pulse Alerts

Alerts are important notes and reminders on time sensitive activities happening in your downline and business. These alerts are shown on your Dashboard, and remain visible until the issue has been resolved or the month ends. There are two type of Pulse alerts: urgent alerts and business alerts.

Urgent Alerts

Urgent alerts communicate business critical information, specifically if you have one or more of the following volume qualification conditions:

- Your SV is below 100 after the 20th of the month.
- You are an EC+, and your PSQV is below 600 after the 20th of the month.
- Your personal CRP has failed.

These alerts require you to acknowledge the message when you log in to Pulse.

After you acknowledge that you have urgent alerts, these alerts are shown at the top of your Dashboard in red, in addition to being listed in the Alerts area. Clicking on an alert provides the functionality or information needed to resolve the issue.

Business Alerts

Business alerts are shown in the Alerts area. Clicking on an alert provides the functionality or information needed to resolve the issue.
How to Access Videos

The Pulse Biz Dev Library provides videos to help you develop and grow your R+F business. These videos can be viewed from within Pulse; certain videos can also be viewed offline. To view a video offline, you need to download the video of interest to your computer.

Downloading a Video

1. From the Pulse Biz Dev Library, enter **Save to Computer** in the **Search for Name** field. Then click **Search**.

![Biz Dev Library Image]

The list of videos that can be download from Pulse is displayed.

2. **Select the video you want to download.**

   The video is automatically downloaded to your computer as a .zip (compressed) file. On Windows, downloaded files are located in your Downloads folder.

3. **Uncompress the file by right-clicking on the .zip file and choosing **Extract All** from the resulting menu.**

![Extract All Option]

4. **Use the resulting dialog box to specify the location where you'd like to save the video, then click **Extract**.**
How to Clear Your Cache

A cache is a part of your browser that transparently stores data so that future requests for that data can be served faster.

Older versions of Pulse Biz Dev Library documents that you have accessed previously might be residing in your cache. In order to ensure that you view the latest versions of these documents, you should clear your cache periodically. The process of clearing a cache is different for the Google Chrome, Internet Explorer, Firefox, and Safari browsers.

Clearing the Google Chrome Cache

1. From the Google Chrome browser, choose Tools > Clear browsing data from the Chrome menu.

2. In the resulting dialog box, from the menu at the top, choose the amount of data that you want to delete. Select beginning of time to delete everything.
Clearing the Internet Explorer Cache

1. From the IE browser, choose **Internet options** from the **Tools menu**.

3. Select **Cached images and files**.

4. Click **Clear browsing data**.
2. Using the General tab > Browser history area of the Internet Options dialog box, click Delete.

3. Click OK at the bottom of the dialog box.

Clearing the Firefox Cache

1. From the Firefox browser, choose Options from the Tools menu.
2. Using the Options dialog box, select the Advanced panel.
3. Click on the **Network** tab.
4. In the **Cached Web Content** section, click **Clear Now**.
5. Click **OK** to close the dialog box.

**Clearing the Safari Cache**

1. From the Safari browser, choose **Preferences** from the **Safari** menu.
2. Using the Preferences window, click the Advanced tab.

3. At the bottom of the window, select the Show Develop menu in menu bar checkbox.
4. Return to the Safari menu bar and choose Develop > Empty Caches.
Getting Started

For new Consultants, the Get Started site provides resources designed to get your R+F business off the ground by working through critical activities. These resources include helpful videos, documents and FAQs.

The Get Started site is also useful for more seasoned Consultants looking for key messages or resources, or in need of a refresher course.

To access the Get Started site from your Pulse Dashboard, click the Get Started shortcut. The Get Started site opens in a new browser window.

Additional information on the Get Started site, and other resources, are:

- Get Started Checklist
- Get Started Options for New Consultants
- Get Started Site FAQs
How to Create an E-mail Signature

Rodan + Fields® provides the ability to create different e-mail signatures for your:

- Pulse e-mails
- Communications Corner custom marketing tools

You can use the e-mail signature for Communications Corner also in Outlook. For Gmail, Yahoo Mail, and Hotmail, this e-mail signature can be used as a virtual business card.

Creating an E-mail Signature for Pulse E-mails

1. From the Pulse Ecomms tab, click **Signature**.

2. Use the **Edit Email Signature** window to create and style your signature, and then click **Save**.

   You cannot add a photo to your e-mail signature, however certain e-mail templates do incorporate the your PWS photo.

Creating an E-mail Signature for Communications Corner

1. From the Communications Corner website (http://communications.rodanandfields.com), select **E-mail Signatures**.
qualification status:

- **Green.** Meet the 600 PSQV requirement.
- **Yellow.** Do not meet the 600 PSQV requirement, but will meet this requirement once the pending autoship is successfully processed.
- **Red.** Do not meet the 600 PSQV requirement, and have no scheduled autoships.

Click **Estimate My PSQV** to see your estimated PSQV if all pending autoships process successfully.

**EC Leg Qualification KPI**

For Executive Consultants (ECs) and above, use the EC Leg Qualification graphic to see how you are tracking toward maintaining your title or achieving a new milestone. As Executive Legs qualify throughout the month, the **Current Process** bar moves up. Your goal is to meet or exceed your performance last month, indicated with the light blue fill line.

Note that though the graph shows your EC Legs as they qualify, you do not attain the corresponding recognition title until you qualify for the month.

If an EC on your personal team is using a grace period to qualify for PSQV, this EC is counted towards your EC Leg qualification starting on the 21st of the month. If they have satisfied their SV requirement. Additionally, any ECs in your personal team using an available grace period for their SV (and having satisfied their PSQV) will be counted if their downline EC has qualified for the month.
Analyzing Your Business Results (Performance Reports)

Performance reports and downline views are available from Pulse to help you analyze your business results and drill down for details. These reports are:

- Flat Downline Tree View
- Vital Signs
- RFx Executive Performance
- RFx Current Performance
- Fast Start - Team Development Bonus
- Fast Start - Team Advancement Bonus
- Promotions
- Autoship CRP/Pulse
- Autoship PC Perks
- PC Cancellations
- Downline
- Earnings Statement
- PSQV
- PEI Activity

Click on the Performance tab to access these reports. The Performance tab displays a summary of your Key Performance Indicators (KPI), and your progress towards qualifying for the Road to RFx Car Incentive Program.
## Pulse Performance Reports Cheat Sheet

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Flat Downline Tree</td>
<td>All Consultants and Preferred Customers in your organization.</td>
<td>Linear representation of your organization. Displays your downline and how your ECs are tracking towards requalification.</td>
<td>View your organizational tree. Drill down into your organization to see who's in each downline leg, and how your ECs in that leg are performing.</td>
</tr>
<tr>
<td>Vital Signs</td>
<td>All Consultants in your organization.</td>
<td>Key performance indicators, including SV, PSQV, Recognition Title, Sponsor.</td>
<td>Send targeted messages. E-mail specific members of your organization; for example, all Consultants in the same state or all LII ECs.</td>
</tr>
<tr>
<td>Promotions</td>
<td>All Consultants in your organization who have at some point promoted to a higher Recognition Title.</td>
<td>First date that a Consultant achieved a specific Recognition Title.</td>
<td>Recognize your superstars. Discover who has promoted and celebrate their achievement. Also see who needs some extra motivation by comparing Recognition Title versus Promotion History.</td>
</tr>
<tr>
<td>PC Cancellations</td>
<td>All cancelled Preferred Customer accounts in your LI.</td>
<td>Preferred Customers who have cancelled their PC Perks account by month.</td>
<td>Don't miss a beat. Manage your monthly PSQV by viewing cancelled PC accounts and their PCVs.</td>
</tr>
<tr>
<td>Downline</td>
<td>All Consultants and Preferred Customers in your organization.</td>
<td>Current month's performance data of your downline.</td>
<td>View current month's performance for your Consultants and Preferred Customers. Supplement your understanding of your business performance for the current month by viewing all your downline information at once.</td>
</tr>
<tr>
<td>Earnings Statement</td>
<td>All Consultants and Preferred Customers on which you have earned in a closed commission period.</td>
<td>Summary statement of overall commission earnings for the specified month.</td>
<td>See you bottom line. Review the results of your hard work every month, and see how each member of your team is contributing to your paycheck.</td>
</tr>
<tr>
<td>PSQV</td>
<td>All personally sponsored Consultants and Preferred Customers.</td>
<td>PSQV from a closed commission period, which is one factor that makes up qualifying volume.</td>
<td>Keep track of your downline's PSQV.</td>
</tr>
<tr>
<td>PEI Activity Report</td>
<td>All Consultants in your organization.</td>
<td>Indicates who on your team is using the PEI and how often.</td>
<td>Coach and train your team members on PEI.</td>
</tr>
</tbody>
</table>

### RFx Reports

<table>
<thead>
<tr>
<th>Who?</th>
<th>What?</th>
<th>Why?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Road to RFx</td>
<td>You.</td>
<td>View your progress in the program. The Road to RFx Car Incentive Program rewards qualified LV ECs with a monthly car allowance towards a leased or purchased vehicle.</td>
</tr>
<tr>
<td>Executive Performance</td>
<td>All ECs in your personal team. Road to RFx and RFx performance for the last closed commission period.</td>
<td>Identify your star performers. Help your ECs set goals along the Road to RFx and track their performance toward those goals.</td>
</tr>
<tr>
<td>Current Performance</td>
<td>All ECs in your personal team. Road to RFx and RFx performance for the current commission period.</td>
<td>Know where your star performers are on the Road to RFx. See how your EC legs are tracking toward their RFx goals in the current period.</td>
</tr>
</tbody>
</table>

### Fast Start Reports

<table>
<thead>
<tr>
<th>Who?</th>
<th>What?</th>
<th>Why?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Team Development Bonus</td>
<td>All Consultants you have personally sponsored in the last 60 days.</td>
<td>Qualification criteria for the Fast Start Team Building Bonus.</td>
</tr>
<tr>
<td>Team Advancement Bonus</td>
<td>All Consultants you have personally sponsored who have never reached a LII EC title or higher.</td>
<td>Includes information on Consultant Recognition Title, Paid-As Title, and Enrollment Date.</td>
</tr>
</tbody>
</table>

### Autoship Reports

<table>
<thead>
<tr>
<th>Who?</th>
<th>What?</th>
<th>Why?</th>
</tr>
</thead>
<tbody>
<tr>
<td>CRP/Pulse</td>
<td>All your LI - LIII Consultants enrolled in CRP.</td>
<td>CRP and Pulse status.</td>
</tr>
</tbody>
</table>

---

Copyright © 2014, Rodan and Fields, LLC
| PC Perks | All your L1 - LIII Preferred Customers. | PC Perks order status. | **Loyalty pays.** Discover the pending volume from Preferred Customers. |
Understanding Your Earnings Statement

The Earnings Statement report provides a wealth of information on your overall commission earning for a specified closed commission period (month).

The report is titled with your name, the commission period, and your Consultant ID (CID), and may include the following sections:

- Summary
- Bonus
- Profit and Adjustments
- Volume
- Total Payment
- Earnings Details

### Summary

<table>
<thead>
<tr>
<th>Summary</th>
<th>LIV EC</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recognition Title</td>
<td></td>
</tr>
<tr>
<td>Paid As Title</td>
<td></td>
</tr>
<tr>
<td>Qualifying SV</td>
<td>110</td>
</tr>
<tr>
<td>Qualifying PSQV</td>
<td>1,162</td>
</tr>
<tr>
<td>Qualifying EC Legs</td>
<td>7</td>
</tr>
<tr>
<td>Qualifying LV EC Legs</td>
<td></td>
</tr>
<tr>
<td>Generations Paid</td>
<td>4</td>
</tr>
<tr>
<td>Qualifying L1+L2 Volume</td>
<td>18,065</td>
</tr>
<tr>
<td>Qualifying L1-L6 Volume</td>
<td>58,290</td>
</tr>
</tbody>
</table>

| Balance From the Prior Period | 216.20 |
| PC Retail Profit              | 53.00  |
| Prior Period Adjustments      | (59.50) |
| Total:                        | 209.70 |

The Summary section of the report shows the selected period’s overall commission earnings.

- **Recognition Title.** Highest title that you have achieved for the prior three commission periods.
- **Paid As Title.** Highest title for which you have satisfied the qualification requirements for the commission period.
- **Qualifying SV.** Total wholesale volume you and/or your Retail Customers have generated.
- **Qualifying PSQV.** Total wholesale volume generated from your personally sponsored Consultants and Preferred Customers.
- **Qualifying EC Legs.** Total number of EC Legs in your organization.
- **Qualifying LV EC Legs.** Total number of Level V EC Legs in your organization.
- **Generations Paid.** Number of generations on which you earned commissions, based on your qualifications and Paid As Title.
- **Qualifying L1+L2 Volume.** Sum of commissionable volumes of L1 and L2, including any roll arounds in your organization.
- **Qualifying L1-L6 Volume.** Sum of commissionable volumes of L1 through L6, including any roll arounds in your organization.

The following information is shown only as it applies to you for the commission period:

- **Balance from the Prior Period.** Amount added to your commission as the result of a balance from the previous commission period.
- **Retail Profit.** Profit earned from your Retail Customers.
- **PC Retail Profit.** Profit earned from PCs.
- **Prior Period Adjustments.** Amount reduced from your commission as the result of any adjustments in the previous commission period.
Bonus

This area is shown if you qualify for any special bonuses for the commission period. Information on your bonuses is broken out by bonus type and includes a total, which is the sum of all bonus.

<table>
<thead>
<tr>
<th>Bonus:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Fast Start Team Building Bonus</td>
<td>50.00</td>
</tr>
<tr>
<td>Total</td>
<td>50.00</td>
</tr>
</tbody>
</table>

Profit and Adjustments

This area of the report is shown if any of the following categories apply to you for the commission period.

- Prior Month Account Bal. Balance of Consultant's earnings from the previous commission period. Consultants who earn less than $20.00 in a commission period do not get paid. Instead the amount due is carried over to the following commission period(s) until the $20.00 threshold is met. This amount can also be a negative number, if the Consultant earned less than amounts that are returned.
- Retail Profit. Profit earned from your Retail Customers.
- PC Retail Profit. Profit earned from your Preferred Customers.
- Return Adjustments. Negative value associated with returns.
- General Adjustments. Any direct earnings adjustments.
- Total. Sum of the values.

Volume

In this area of the report, you see the volume in your organization.

<table>
<thead>
<tr>
<th>Volume:</th>
<th>Commissionable Volume</th>
<th>% Earned</th>
<th>Earnings in Volume</th>
<th>Exchange Rate To USD</th>
<th>Commissions (USD)</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1 Volume</td>
<td>4,150</td>
<td>10.00%</td>
<td>415.00</td>
<td>1.00</td>
<td>$415.00</td>
</tr>
<tr>
<td>Personal Team Volume*</td>
<td>4,445</td>
<td>5.00%</td>
<td>222.25</td>
<td>1.00</td>
<td>$222.25</td>
</tr>
<tr>
<td>Gen I Volume</td>
<td>16,042</td>
<td>5.00%</td>
<td>802.10</td>
<td>1.00</td>
<td>$802.10</td>
</tr>
<tr>
<td>Gen II Volume</td>
<td>12,717</td>
<td>5.00%</td>
<td>635.85</td>
<td>1.00</td>
<td>$635.85</td>
</tr>
<tr>
<td>Gen III Volume</td>
<td>15,749</td>
<td>5.00%</td>
<td>787.45</td>
<td>1.00</td>
<td>$787.45</td>
</tr>
<tr>
<td>Gen IV Volume</td>
<td>7,683</td>
<td>5.00%</td>
<td>384.15</td>
<td>1.00</td>
<td>$384.15</td>
</tr>
<tr>
<td>Gen V Volume</td>
<td>1,654</td>
<td>0.00%</td>
<td>-</td>
<td>1.00</td>
<td>$0.00</td>
</tr>
<tr>
<td>Total Org Volume**</td>
<td>58,290</td>
<td></td>
<td>3,246.80</td>
<td>1.00</td>
<td>$3,246.80</td>
</tr>
</tbody>
</table>

*Personal Team (Includes L1 Volume)
**Personal Team Plus Generational Volume

- **L1 Volume.** PCV of your personally sponsored PC purchases, as well as the PCV of purchases of PCs who roll up to your Level 1 due to compression. SV of your personally sponsored Consultants, as well as the SV of Consultants who roll up to your Level 1 due to compression. (All L1 Preferred Customers and the SV of all L1 Consultants regardless of the original sponsor.
- **Personal Team Volume.** Level 1 volume plus SV of the first qualified EC in any downline Leg, with the exception of any Consultants that may roll around you due to demotion.
- **Gen x Vol.** Total volume of your Generation x.

Note: You may see volume in generations for which you are not eligible to earn commissions, based on your current commission period.

Paid As Title.
Total Org Volume. Personal team volume plus the sum of your Generation I through Generation V volume.

RFx (Gen VI) Volume. Total volume of your Generation VI. Note that this volume does not count as part of your Org Volume.

Total Payment

Sum of all total lines in the report, and how you received the payment.

Earnings Details

The lower portion of the report provides details on the volume generated and earnings breakdown for each individual in your organization on which you earned commissions.

<table>
<thead>
<tr>
<th>Paid As Title</th>
<th>CID</th>
<th>Generation</th>
<th>Level</th>
<th>EC Anniversary Month</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIV EC</td>
<td>001666</td>
<td>Personal Team</td>
<td>1</td>
<td>201404</td>
</tr>
<tr>
<td>C</td>
<td>010079</td>
<td>Personal Team</td>
<td>1</td>
<td>201402</td>
</tr>
<tr>
<td>EC</td>
<td>010155</td>
<td>Personal Team</td>
<td>1</td>
<td>201402</td>
</tr>
<tr>
<td>EC</td>
<td>011944</td>
<td>Personal Team</td>
<td>1</td>
<td>201403</td>
</tr>
</tbody>
</table>

- **Paid As Title.** Highest Qualification Title achieved in a commission period.
- **CID.** Consultant ID.
- **Generation.** Generation the individual sits on in your organization.
- **Level.** Level achieved.
- **EC Anniversary Month.** This date specifies when the Consultant's next grace period becomes available.
- **Transaction Type.** Sale or Return.
- **Qualifying Volume.** Volume used by Consultants to qualify for titles and commissions. Made up of Sales Volume and Personally Sponsored Qualifying Volume.
- **CV (Commissionable Volume).** Volume generated by purchases from a Consultant's downline upon which they are eligible to receive commissions based on their qualifications.
- **Total.** Total earnings.
- **PC Retail Profit.** Profit earned from PCs.
- **L1.** Level 1 commission.
- **PT.** Where the volume is attributed. For example, if the individual is someone you personally sponsored, their volume is going to be attributed to your PSQV.
- **Gen X Generation X override commission.**
- **RFx (Gen VI).** RFx override commission.
Using Reports and Views

Using a report can involve:

- Opening a report
- Sorting information
- Sending e-mail
- Viewing additional information on an individual
- Exporting report data to another application

Opening a Report

1. From Pulse, click the **Performance** tab.
2. Select the report you want to open from the left panel.

The report opens in a new browser window, showing the most current information.

**Note:** If a new browser window does not open, disable popup blockers.

Sorting Information

Certain report columns can be sorted. To identify sortable columns, hover your cursor over a column heading; sortable columns display a hyperlink and the tooltip **Sort by**. To sort the information in that column in either ascending or descending order, click the column heading.

An up/down arrow in a column heading identifies the column by which the report is currently sorted.

Sending E-mail

Some reports allow you to send e-mails from the report using your Pulse e-mail account. You can send an e-mail to selected individuals, or everyone listed in the report.

- To e-mail certain individuals only, select those individuals in the report and then click **Email Selected On Page**.
- To e-mail everyone in the report (including those individuals displayed on additional report pages not shown), click **Email All in This**.
The Ecomms e-mail editor opens, allowing you to compose and send an e-mail to each individual.

Viewing Additional Information on an Individual

Certain reports provide the ability to view additional information on an individual.

1. In the report, click on the name of the individual of interest. Their Info Card is displayed.

2. From the Info Card you can see the individual in a linear representation of your organization by clicking Flat Downline Tree. Click on the individual’s e-mail address to send an e-mail from the report using your Pulse e-mail account.

Exporting Data

1. Choose from the Export drop-down menu the application you want.
2. Use the resulting dialog box to open and/or save the file.
Report Options

Many Pulse Performance reports have options that you can use to narrow the data that appears in the report. Some of these options, and other options unique to a report, are shown by clicking the View More Filter Options.

For options with a **Min** and **Max** range, you can filter by either the minimum value, the maximum value, or by the entire range.

![Image](https://example.com/image.png)

**Note:** A report displays the information based on your options until you choose to either remove all filters by clicking **Clear Searches & Filters**, select a different tab, or close the current Pulse session.

Options that are common across multiple reports are:

- **CID.** Consultant ID.
- **Country.** Choose either United States or Canada.
- **Enrollment Date.** Date enrolled as a Consultant.
- **L1+L2 Qualifying Volume.** Sum of commissionable volumes of L1 and L2, including any roll arounds in your organization.
- **L1-L6 Qualifying Volume.** Sum of commissionable volumes of L1 through L6, including any roll arounds in your organization. Since your organization volume is constantly changing throughout the month as Executive Consultants promote and generations emerge, the L1 - L6 volume helps you gauge your performance. In most cases, your organization volume is at least the amount of your L1 - L6 volume.
- **Level.** Within your organization.
- **Name (Search for).** Enter the name (first name, last name, or both) of the individual of interest in the Search for Name field. As you type, matching results are shown. If no results are shown, make sure you are searching for an individual in your organization and that you are spelling the name correctly.
- **Number of EC Legs in Personal Team.** Downline legs that contain a qualified Executive Consultant. The number of EC legs determines the recognition title of that Executive Consultant.
- **Number of LV EC Legs in Personal Team.** Level V (5) downline legs that contain a qualified Executive Consultant.
- **Order Type.** Select the type of order you are interested in from the drop-down menu.
- **Paid As Title.** Highest Qualification Title achieved in a commission period. Used to calculate commission due for each pay period. From the drop-down menu, choose the title in which you are interested.
- **Period.** Choose a time period, other than the current time period which is shown by default, from the report's **Period** drop-down menu.
- **PSOV (Personally Sponsored Qualifying Volume).** Volume of all purchases of R+F products made by Personally Sponsored Preferred Customers and Personally Sponsored Consultants and their Retail Customers.
- **Qualification Title.** Title for which a Consultant qualifies as a commission period progresses. The Qualification Title changes throughout the commission period as performance targets are met.
- **Recognition Title.** Consultant's highest Paid-As Title achieved in the last three consecutive commission periods.
- **Sponsor Name.** Name of Consultant's or PC's sponsor.
- **State.** Available if the Country option is the United States.
- **SV (Sales Volume).** Volume of a Consultant's personal purchases (either for personal consumption or for resale to Customers), plus the volume of purchases made directly from R+F by the Consultant’s Retail Customers.
Road to RFx Report

The Road to RFx Car Incentive Program rewards qualified LV ECs with a monthly car allowance towards a leased or purchased vehicle. Use the Road to RFx report to view your progress in the program.

To see your Road to RFx report, click the Performance tab. The report is displayed below your KPIs on the tab. The data in this report is:

- **EC Legs**: Downline legs that contain a qualified Executive Consultant. The number of EC legs determines the recognition title of that Executive Consultant.
- **LV EC Legs**: Level V (5) downline legs that contain a qualified Executive Consultant.
- **L1+L2 Vol**: Sum of commissionable volumes of L1 and L2, including any roll arounds in your organization.
- **L1-L6 Vol**: Sum of commissionable volumes of L1 through L6, including any roll arounds in your organization. Since your organization volume is constantly changing throughout the month as Executive Consultants promote and generations emerge, the L1 - L6 volume helps you gauge your performance. In most cases, your organization volume is at least the amount of your L1 - L6 volume.

For detailed information on this program, refer to the Road to RFx Car Incentive Program Terms and Conditions.
Flat Downline Tree View

The Flat Downline Tree view displays a linear representation of your organization. Your downline (Consultants and Preferred Customers) is shown, including team members who have rolled up to you. If you have lost a downline Leg due to a roll around, the personally sponsored Consultant remains in your reports but the remainder of that EC Leg is not visible.

Use this view to see how your ECs are tracking towards requalification, and to drill down into your organization.

Color coding before a team member’s name is used to provide information at a glance. Refer to the Legend, to the left of the report, for help in interpreting the report. For further details and definitions of the Rodan + Fields Compensation Plan, refer to the R+F Policies and Procedures.

To use the Flat Downline Tree view:

1. From Pulse, click the Performance tab.
2. Click the Flat Downline Tree shortcut.
3. To narrow the view to a specific team member, enter their name in the Search for name field. As you type, matching results are shown. Select the appropriate name and then click Search.
4. If you want to narrow the view to only PCs, check the PCs box and then click Apply Filter. To view only ECs, make sure both boxes are unchecked.
5. To drill down on a team member's organization, click the right arrow next to their name. The individual's organization is shown to their next level. You can then further drill down in that organizational leg. If you are looking for a specific person, use the Search for name feature to jump to that person without expanding one level at a time.
6. For additional information about a team member, click on their name. Their Info Card is displayed.
7. If you want to e-mail an individual from the Flat Downline Tree view, click on their name. From their Info Card, click on their e-mail address to open the Pulse e-mail editor with the e-mail address automatically included.
Vital Signs Report

Available to Pulse Pro subscribers only

Use the Vital Signs report to view the key performance indicators for all Consultants in your organization. Information in this report is updated in near real-time, so as transactions occur within your organization, they can be seen right away. From this report, you can also e-mail specific members of your organization.

The Vital Signs report does not include information on your Preferred Customers. To see your PCs volume, use either the Autoship PC Perks report or your Order History.

Note: Information on your organization volume can not be shown in real-time, since this volume is constantly changing throughout the month as Executives promote and generations emerge. Instead use the L1 - L6 QV data to help you gauge your performance. In most cases, your organization volume is at least the amount of your L1 - L6 qualifying volume.

<table>
<thead>
<tr>
<th>Enrollment Date</th>
<th>SV</th>
<th>PSQV</th>
<th>% PSQV C</th>
<th>% PSQV PC</th>
<th>L1+L2 QV</th>
<th>L1-L6 QV</th>
<th>EC Legs</th>
<th>LV EC Legs</th>
<th>Rec. Title</th>
<th>Paid As Title</th>
<th>Qual. Title</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/06/2009</td>
<td>0</td>
<td>2376</td>
<td>18</td>
<td>82</td>
<td>24843</td>
<td>467715</td>
<td>11</td>
<td>0</td>
<td>C*</td>
<td>RFx</td>
<td>PSL1</td>
<td></td>
</tr>
<tr>
<td>08/31/2009</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>C*</td>
<td>C*</td>
<td>PSL1</td>
<td></td>
</tr>
<tr>
<td>09/15/2009</td>
<td>20</td>
<td>1771</td>
<td>20</td>
<td>80</td>
<td>18116</td>
<td>156329</td>
<td>6</td>
<td>0</td>
<td>C*</td>
<td>RFx</td>
<td>PSL1</td>
<td></td>
</tr>
</tbody>
</table>

In order to view your Vital Signs, open the report. Then specify the report's options and click Run Report. Options unique to this report, and available by clicking the View More Filter Options, are:

- **Perf. Sponsor.** Immediate upline sponsor. The Performance Sponsor can change based on terminations and roll-arounds, and may be different than the enrolling sponsor.
- **Pulse Subscriber.** Yes or No.
- **Paid As/Qual. Title.** Highest Qualification Title achieved in a commission period. Used to calculate commission due for each pay period. From the drop-down menu, choose the title in which you are interested.
- **EC Legs.** Downline Legs that contain a qualified Executive Consultant. The number of EC Legs determines the recognition title of that Executive Consultant.
- **LV EC Legs.** Level V (5) downline Legs that contain a qualified Executive Consultant.

Once the report's data is displayed, you can:

- Sort the information.
- Export the data to another application.
- Send e-mails using your Pulse email account.
- View additional information on an individual.
RFx Executive Consultants Report

The RFx Executive Consultants report identifies your star performers. For all ECs in your personal team, the report shows how they are tracking towards key milestones (including RFx title qualification) on the Road to RFx for closed commission period.

Note: Information on your organization volume cannot be shown in real-time, since this volume is constantly changing throughout the month as Executive Consultants promote and generations emerge. Instead use L1 - L6 qualifying volume data to help you gauge your performance. In most cases, your organization volume is at least the amount of your L1 - L6 qualifying volume.

For information on your personal RFx qualification, see the Road to RFx report. To see details on an EC’s Leg, use the Flat Downline Tree view.

<table>
<thead>
<tr>
<th>Recognized Title</th>
<th>Paid As Title</th>
<th>Grace Balance</th>
<th>SV</th>
<th>PSQV</th>
<th>L1+L2 Qualifying Volume</th>
<th>L1-L6 Qualifying Volume</th>
<th># of EC Legs in Personal Team</th>
<th># of LV EC Legs in Personal Team</th>
<th>Year to date months paid as RFx</th>
</tr>
</thead>
<tbody>
<tr>
<td>RFx</td>
<td>RFx</td>
<td>1</td>
<td>131</td>
<td>22367</td>
<td>136,012</td>
<td>1,399,762</td>
<td>28</td>
<td>9</td>
<td>9</td>
</tr>
<tr>
<td>LIV EC</td>
<td>LIII EC</td>
<td>1</td>
<td>740</td>
<td>7313</td>
<td>18,634</td>
<td>25,042</td>
<td>5</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LI EC</td>
<td>LI EC</td>
<td>0</td>
<td>335</td>
<td>491</td>
<td>1,906</td>
<td>2,815</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LII EC</td>
<td>LII EC</td>
<td>1</td>
<td>350</td>
<td>5798</td>
<td>8,268</td>
<td>8,413</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>LV EC</td>
<td>LV EC</td>
<td>1</td>
<td>886</td>
<td>9097</td>
<td>26,563</td>
<td>60,485</td>
<td>8</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>EC</td>
<td>EC</td>
<td>1</td>
<td>1010</td>
<td>1305</td>
<td>1,493</td>
<td>1,493</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>RFx</td>
<td>RFx</td>
<td>1</td>
<td>768</td>
<td>13672</td>
<td>77,803</td>
<td>618,905</td>
<td>21</td>
<td>5</td>
<td>1</td>
</tr>
</tbody>
</table>

To use the RFx Executive Consultants report, open the report and click the Executive Consultants tab. Then specify the report’s options and click Run Report.

Once the report's data is displayed, you can:

- Sort the information.
- Export the data to another application.
- Send e-mails using your Pulse email account.
- View additional information on an individual.
RFx Current Performance Report

Available to Pulse Pro subscribers only

If you want to know where your star performers are on the Road to RFx, use the RFx Current Performance report. This report illustrates how your EC Legs are tracking toward their RFx goals (including RFx title qualification) in the current commission period.

Note: Information on your organization volume can not be shown in real-time, since this volume is constantly changing throughout the month as Executive Consultants promote and generations emerge. Instead use L1 - L6 qualifying volume data to help you gauge your performance. In most cases, your organization volume is at least the amount of your L1 - L6 qualifying volume.

For information on your personal RFx qualification, see the Road to RFx report. To see details on an EC's Leg, use the Flat Downline Tree view.

<table>
<thead>
<tr>
<th>Recognized Title</th>
<th>Paid As Title</th>
<th>Qualification Title</th>
<th>Grace Balance</th>
<th>SV</th>
<th>PSQV</th>
<th>L1+L2 Qualifying Volume</th>
<th>L1-L6 Qualifying Volume</th>
<th># of EC Legs in Personal Team</th>
<th># of LV EC Legs in Personal Team</th>
</tr>
</thead>
<tbody>
<tr>
<td>LIV EC</td>
<td>LIII EC</td>
<td>EC</td>
<td>273</td>
<td>1,374</td>
<td>4,801</td>
<td>7,693</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>LV EC</td>
<td>LV EC</td>
<td>LI EC</td>
<td>105</td>
<td>1,972</td>
<td>4,855</td>
<td>16,819</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>EC</td>
<td>EC</td>
<td>EC</td>
<td>121</td>
<td>691</td>
<td>691</td>
<td>691</td>
<td>0</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>RFx</td>
<td>RFx</td>
<td>C&quot;</td>
<td>20</td>
<td>1,771</td>
<td>18,116</td>
<td>157,063</td>
<td>6</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>LII EC</td>
<td>LII EC</td>
<td>C&quot;</td>
<td>20</td>
<td>901</td>
<td>3,487</td>
<td>10,602</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>LV EC</td>
<td>LV EC</td>
<td>LI EC</td>
<td>218</td>
<td>1,178</td>
<td>3,832</td>
<td>4,628</td>
<td>1</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

To use the RFx Current Performance report, open the report and click the Current Performance tab. Then specify the report's options and click Run Report.

Once the report's data is displayed, you can:

- Sort the information.
- Export the data to another application.
- Send e-mails using your Pulse email account.
- View additional information on an individual.
Fast Start - Team Development Bonus Report

Available to Pulse Pro subscribers only

Use the Fast Start - Team Development Bonus report to determine which of your newly enrolled Consultants are eligible for the Fast Start program bonus, and track your Fast Start Team Build earning potential. Newly enrolled Consultants are those you have personally sponsored within the last 60 days.

<table>
<thead>
<tr>
<th>Enrollment Date</th>
<th>Enrollment Month SV</th>
<th>CRP Enrollment Date</th>
<th>Month 2 SV</th>
</tr>
</thead>
<tbody>
<tr>
<td>08/21/2014</td>
<td>900</td>
<td>08/21/2014</td>
<td>185</td>
</tr>
</tbody>
</table>

To use the Fast Start - Team Development Bonus report, open the report and click the Team Development Bonus tab. Then specify the report's option and click Run Report. From the report you can:

- Sort the information.
- Export the data to another application.
- Send e-mails using your Pulse email account.
- View additional information on an individual.
Fast Start - Team Advancement Bonus Report

Available to Pulse Pro subscribers only

The Fast Start - Team Advancement Bonus report shows all Consultants you have personally sponsored who have never reached a recognition title of LII EC+. Use this report to maximize your Fast Start Team Advancement earning potential, since for every Consultant listed in this report that you help reach a LII EC title, you receive a bonus.

<table>
<thead>
<tr>
<th>Recognition Title</th>
<th>Qualification Title</th>
<th>Enrollment Date</th>
<th>LII Achievement Period</th>
</tr>
</thead>
<tbody>
<tr>
<td>C*</td>
<td>C*</td>
<td>04/30/2012</td>
<td>0</td>
</tr>
<tr>
<td>C*</td>
<td>C*</td>
<td>10/26/2011</td>
<td>0</td>
</tr>
<tr>
<td>C*</td>
<td>C*</td>
<td>02/23/2011</td>
<td>0</td>
</tr>
<tr>
<td>C*</td>
<td>C*</td>
<td>10/01/2009</td>
<td>0</td>
</tr>
<tr>
<td>C*</td>
<td>C*</td>
<td>08/14/2009</td>
<td>0</td>
</tr>
<tr>
<td>EC</td>
<td>EC</td>
<td>08/06/2013</td>
<td>0</td>
</tr>
</tbody>
</table>

To use the Fast Start - Team Advancement Bonus report, open the report and click the Team Development Bonus tab. Then specify the report's options and click Run Report.

Once the report's data is displayed, you can:

- Sort the information.
- Export the data to another application.
- Send e-mails using your Pulse email account.
- View additional information on an individual.
Promotions Report

Available to Pulse Pro subscribers only

Recognize your organization's superstars, and see who needs some extra motivation, by using the Promotions report. This report shows all downline team members in your organization who have at some point promoted to EC or higher title, and the date they achieve a specific Recognition Title. If a Consultant has promoted to an EC title more than once, the report shows the first date this title was achieved.

To use the Promotions report, open the report. Then specify the report's options and click Run Report. Options unique to this report provide information on the date a Consultant achieved a recognition title. These options are available by clicking the View More Filter Options.

Options return data on the (first) date, in the date range specified, that the Consultant promoted to the title. If you want information on just newly promoted Consultants, use the min and max fields of the appropriate recognition title Date option, to select the previous month.

Once the report's data is displayed, you can:

- Sort the information.
- Export the data to another application.
- Send e-mails using your Pulse email account.
- View additional information on an individual.
Autoship CRP/Pulse Report

The Autoship CRP/Pulse report provides insight into all pending, processed, first month and failed CRP orders, including Pulse subscriptions. The data is displayed for yourself and your downline Consultants enrolled in CRP (LI-LIII), by commission period. Using this report, you can identify Consultants whose CRP order has failed (which puts their entire business at risk), and proactively manage your downline by reaching out to these Consultants by the 20th of the month.

To use the Autoship CRP report, open the report and click on the CRP tab. Then specify the report's options and click Run Report. Options unique to this report, and available by clicking the View More Filter Options, are:

- **CRP Status.** Status of CRP orders. If you want to check for failed CRP orders, choose Failed from the CRP Status drop-down menu.

- **Pulse Status.** Status of Pulse orders. If you want to check for failed Pulse orders, choose Failed from the Pulse Status drop-down menu.

To see which Consultant's are using the 30-day free trial of Pulse Pro, choose First Month from the Pulse Status drop-down menu.

Once the report's data is displayed, you can:

- Sort the information.
- Export the data to another application.
- Send e-mails using your Pulse email account. If you want to send an e-mail to those individuals with failed autoships, choose the CRP Status > Failed option, and then click the appropriate e-mail feature (Email Selected On Page or Email All in This Report).
- View additional information on an individual.
Autoship PC Perks Report

To discover the PC Perks pending volume of your Preferred Customers (LI-LIII), use the Autoship PC Perks report. The report lists all pending, processed, off-month and failed PC Perks orders.

<table>
<thead>
<tr>
<th>PC Perks Enrollment Date</th>
<th>PC Perks Date</th>
<th>PC Perks Status</th>
<th>QV</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/04/2010</td>
<td>11/04/2014</td>
<td>Off Month</td>
<td>75</td>
</tr>
<tr>
<td>02/15/2010</td>
<td>10/15/2014</td>
<td>Processed</td>
<td>78</td>
</tr>
<tr>
<td>03/13/2010</td>
<td>11/07/2014</td>
<td>Off Month</td>
<td>79</td>
</tr>
<tr>
<td>05/03/2010</td>
<td>11/03/2014</td>
<td>Off Month</td>
<td>100</td>
</tr>
<tr>
<td>06/17/2010</td>
<td>10/17/2014</td>
<td>Processed</td>
<td>135</td>
</tr>
<tr>
<td>11/21/2010</td>
<td>11/20/2014</td>
<td>Off Month</td>
<td>145</td>
</tr>
<tr>
<td>03/03/2011</td>
<td>10/03/2014</td>
<td>Processed</td>
<td>145</td>
</tr>
</tbody>
</table>

To use the Autoship PC Perks report, open the report and click on the PC Perks tab. Then specify the report’s options and click Run Report. Options unique to this report, and available by clicking the View More Filter Options, are:

- **PC Perks Status.** Status of the order. If you want to check for failed PC Perks replenishment orders, choose Failed from the PC Perks Status drop-down menu.

- **PC Perks Enrollment Date.** Date the individual enrolled in the PC Perks program.
- **PC Perks Date.** Date of next PC Perks shipment.
- **QV.** Qualifying volume.

To see the PC Perks orders that are off-month, so that you can plan for next month, choose Off-Month.

Once the report’s data is displayed, you can:

- **Sort the information.**
- **Export the data to another application.**
- **Send e-mails, to your personal Preferred Customers (only), using your Pulse email account.** If you want to send an e-mail to those individuals with failed autoships, choose the CRP Status > Failed option, and then click the appropriate e-mail feature (Email Selected On Page or Email All in This Report).
- **View additional information on an individual.**
PC Cancellations Report

The PC Cancellations report identifies your Preferred Customers (LI) who have cancelled their PC Perks account, by commission period. This report makes it easy for you to manage your monthly PSQV by viewing cancelled PC accounts and their PCVs.

<table>
<thead>
<tr>
<th>Enrollment Date</th>
<th>Cancellation Date</th>
<th>Last PC Perks Date</th>
<th>Last QV</th>
</tr>
</thead>
<tbody>
<tr>
<td>05/15/2014</td>
<td>10/15/2014</td>
<td>05/15/2014</td>
<td>201</td>
</tr>
</tbody>
</table>

To use the PC Cancellations report, open the report. Then specify the report's options and click Run Report.

Once the report's data is displayed, you can:

- Sort the information.
- Export the data to another application.
- Send e-mails, to your personal Preferred Customers (only), using your Pulse email account.
- View additional information on an individual.
Downline Report

Use the Downline report to view the current month's performance of your downline (Consultants and Preferred Customers in your organization), including SV, PSQV and Grace balance. The data in this report supplements your understanding of your business performance for the current month by providing a view of all your downline information at once.

To use the Downline report, open the report. The report opens in a new browser window. Then specify the report's options and click View Report.

If you want to export the report data to another application, from the Export icon drop-down menu select the appropriate export format.
Earnings Statement Report

The Earnings Statement report is a summary of your overall commission earning for specified closed commission periods (months). This includes the titles, organization volumes, any qualified bonuses and the earnings breakdown of each individual in your organization on which you earned commissions.

See the topic Understanding Your Earnings Statement for help on interpreting this report.

Note: This report does not display the current month’s earnings. A commission period must be closed (typically happens around the 10th-15th of each month) for that month’s information to be displayed in the Earnings Statement report. So if you are looking at your Earnings Statement report right before a commission period closes, your current report is approximately 2 months old.

In order to view your Earnings Statement, open the report, which opens in a new browser window. Then specify the report’s options and click View Report.

If you want to export the report data to another application, from the Export icon drop-down menu select the appropriate export format.
PSQV Report

The PSQV report allows you to see, for all personally sponsored Consultants and Preferred Customers, their PSQV (including pending CRP) for a closed commission period. Using this report, you can keep track of your downline's qualifying volume.

<table>
<thead>
<tr>
<th>Account Type</th>
<th>Recognized Title</th>
<th>PaidAs Title</th>
<th>Qual Title</th>
<th>Order Type</th>
<th>Order Number</th>
<th>PSQV</th>
<th>Order Status</th>
<th>Commission Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Consultant</td>
<td>C</td>
<td>C</td>
<td>C</td>
<td>CRP</td>
<td>9701912</td>
<td>20 Shipped</td>
<td></td>
<td>10/20/2014</td>
</tr>
<tr>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>PC Order</td>
<td>9891102</td>
<td>165 Submitted</td>
<td></td>
<td>10/22/2014</td>
</tr>
<tr>
<td>Consultant</td>
<td>EC</td>
<td>EC</td>
<td>EC</td>
<td>CRP</td>
<td>9445944</td>
<td>20 Shipped</td>
<td></td>
<td>10/03/2014</td>
</tr>
<tr>
<td>Consultant</td>
<td>EC</td>
<td>EC</td>
<td>EC</td>
<td>CRP</td>
<td>9444763</td>
<td>90 Shipped</td>
<td></td>
<td>10/03/2014</td>
</tr>
<tr>
<td>PC</td>
<td></td>
<td></td>
<td></td>
<td>PC Perks</td>
<td>9555263</td>
<td>216 Shipped</td>
<td></td>
<td>10/13/2014</td>
</tr>
<tr>
<td>Consultant</td>
<td>LIV EC</td>
<td>LIV EC</td>
<td>LIV EC</td>
<td>CRP</td>
<td>9694811</td>
<td>20 Shipped</td>
<td></td>
<td>10/20/2014</td>
</tr>
<tr>
<td>Consultant</td>
<td>EC</td>
<td>EC</td>
<td>EC</td>
<td>CRP</td>
<td>9626031</td>
<td>20 Shipped</td>
<td></td>
<td>10/18/2014</td>
</tr>
<tr>
<td>Consultant</td>
<td>EC</td>
<td>EC</td>
<td>EC</td>
<td>CRP</td>
<td>9624571</td>
<td>304 Shipped</td>
<td></td>
<td>10/18/2014</td>
</tr>
</tbody>
</table>

To use the PSQV report, open the report. Then specify the report's options and click Run Report. Options unique to this report, and available by clicking the View More Filter Options, are:

- **Account Type.** All, PC, or Consultant.
- **Order Type.** Includes orders, returns and subscriptions.
- **Roll Arounds.** Changes to the performance lineage due to roll-arounds.
  
  A roll-around results from either a title demotion or failure to promote; the Consultant's downline is reassigned to the next highest EC in that Consultant's organizational tree.

Information in the report is group by order status. Product returns are highlighted in red.

Once the report's data is displayed, you can:

- Sort the information.
- Export the data to another application.
- Send e-mails using your Pulse email account.
- View additional information on an individual.
PEI Activity Report

The PEI Activity Report indicates who on your team is using the PEI and how often. Use this report to coach and train your team members on PEI.

In order to view the PEI Activity report, open the report. Then specify the report's options and click Run Report.
Finding Information on Grace Periods and Roll Aroun ds

You can find information on your organization’s grace periods and roll arounds from the Flat Downline Tree view.

Roll arounds in your organization are indicated by an annotation next to the individual’s name.

For both your own, and individuals in your downline, grace periods just click on your own name, or the name of the person of interest. The resulting Info Card shows grace period related information, including Grace Balance and EC Anniversary (which indicates the next available grace period). This information is useful because, if an EC on your personal team is using a grace period to qualify for the PSQV and has satisfied their SV requirement, this EC is counted towards your EC leg qualification starting on the 21st of the month. Additionally, any ECs in your personal team using an available grace period for their SV (and has satisfied their PSQV) will be counted if their downline EC has qualified for the month.
Pulse provides a full business library that provides information on all aspects of developing your R+F business. This includes business forms, training materials, user guides and frequently asked questions, videos and other business resources.

To access this library, click the Biz Dev Library tab. A complete list of all available resources is shown.

You can narrow your search for material by clicking on the appropriate resource category at the left, specifying the resource name (title or keyword, not content), and/or identifying the country of interest. Then click Search.

Content that meet your search criteria is displayed. You can then sort the list by Name, Category, or Date Added in either ascending or descending order, by clicking the column heading.

Click on a title in the list to view it. The content opens in a new browser window.

You can save the file to your computer. Once saved, a file can then be attached to an email.

Some material in PDF format can be customized (for example product flyers) with your contact information. Simply highlight the field, enter your information, and save the file to your computer.
The R+F Social Networking (RFSN) application allows you to create widgets, or mini advertisements, from your Facebook page. For example, you may want to create a RFSN widget to share a video or image with a specific call to action (like Buy Now) which links directly to your PWS.

Links to RFSN widgets can be included in other social media sites (like Twitter and Pinterest), in an e-mail, or in your own blog or website.

To access the RFSN widget, from your Pulse Dashboard, click the RFSN Widget shortcut. The RFSN Widget page opens in a new browser window.

For information on creating, managing, and tracking widgets, refer to the RFSN Widget User Guide.
Managing Leads (Contacts)

Available to Pulse Pro subscribers only

Use the Contacts tab, which provides the following lists of contacts, to manage business leads:

- Personal Team Consultants
- Preferred Customers
- Contacts from the Solution Tool
- Other Contacts

Managing leads involves:

- Viewing a contact list
- Narrowing the information in a contact list
- Sending e-mail to a contact
- Sorting information in a contact list
- Displaying details on a contact

Note that with this version of Pulse, you can't synchronize your contacts with your mobile phone. When a Consultant or Preferred Customer account has **no** identified main address (address of record), the address field in a contact list is blank. Even though an account may have multiple shipping and billing addresses, each individual must identify their main address. Encourage your Consultants to **identify their main address using Pulse**. For Preferred Customers, have them e-mail PC Perks Support with their main address information.

Viewing a Contact List

1. From Pulse, click the **Contacts** tab.
2. Select the list you want to open from the left panel, under **Contact Groups**.

Narrowing Information on a List

1. Enter the name (first or last name) of the individual of interest in the **Search for Name** field.
2. Click **Search**.
Note: A contact list displays information based on the **Search for Name** field until you choose to either remove the filter by clicking **Clear Searches & Filters**, or select a different tab, or close the current Pulse session.

**Sending E-mail**

You can send e-mails to selected contacts, or everyone in a contact list, using your Pulse e-mail account. E-mails can be sent from the **Contact** tab and from certain contact lists.

- To e-mail all your personal team Consultants, or all your Preferred Customers, click the appropriate shortcut.

- To e-mail certain individuals only, select those individual in a contact list, and then click **Email Selected On Page**.

- To e-mail everyone in a contact list (including those individuals displayed on additional list pages not shown), click **Email All in This Report**.

The **Ecomms e-mail editor** opens, allowing you to compose and send an e-mail to each individual.

**Sorting Information**

The **First Name** column of a contact list can sorted, as indicated by the up/down arrow.

- Click the column heading to sort the information in that column in either ascending or descending order.
Displaying Details on a Contact

1. In the list, click on the name of the individual of interest. Details displayed are Contact Information and Order History. The Commission Date column of the Order History can be sorted in either ascending or descending order, by clicking the column heading.

2. To e-mail the individual using your Pulse e-mail account, **Send an Email** under the Correspondence area. The **Ecomms e-mail editor** opens, allowing you to compose and send the e-mail.
My Personal Team Consultants

Available to Pulse Pro subscribers only

Contact information for your personal team Consultants automatically appear in the My Personal Team Consultants contact list. This information includes their name, e-mail, address, phone number, and order history. The My Personal Team Consultants contact list can **not** be edited or deleted.

Note that Consultants outside of your personal team do not appear on this contact list. If you want information on (or to e-mail) **all** Consultants in your downline, use the Vital Signs report.

Contact information for your Preferred Customers can be found on the My Preferred Customers contact list. For Retail Customers, use the My Contacts list.
My Preferred Customers

Available to Pulse Pro subscribers only

Contact information for your Preferred Customers automatically appears in the My Preferred Customers contact list. This information includes their name, e-mail, address, phone number, and order history. The My Preferred Customers contact list can not be edited or deleted.

Contact information for your personal team Consultants can be found on the My Personal Team Consultants contact list. For Retail Customers, use the My Contacts list.
Solution Tool Contacts

Available to Pulse Pro subscribers only

Use the Solution Tool Contacts list to view Customers and prospects who have used the R+F Solution Tool from your PWS. This information makes it quick and easy to follow up with an individual interested in R+F products.

The Solution Tool Contacts list is displayed in a new browser window. The Date & Time column indicates when the individual finished using the Solution Tool.

Using the Solution Tool Contacts list, you can:

- Narrow the information on the list.
- Display an individual’s personalized Solution Tool routine.
- Delete an individual from the list.

Refer to the Solution Tool FAQ for additional information on the R+F Solution Tool.

Narrowing Information on the List

1. Enter the name (first or last name) or e-mail of the prospect in the Search field.
2. Click Search.

Displaying Details on an Individual’s Personalize Routine

- From the list, click on the name of the individual. That individual’s personalized Solution Tool routine is shown.

Deleting an Individual from the List

- From the list, click on the X associated with the individual you want to delete.
Other Contacts

Available to Pulse Pro subscribers only

You can create a My Contacts list for all other contacts, such as your Retail Customers and personal contacts.

Contact information for Retail Customers can be found by viewing the details of an order for a specific Retail Customer.

Creating a My Contacts list involves:

- Adding a contact
- Importing contacts
- Editing a contact
- Deleting a contact

Adding a Contact

1. From the left panel, click Add a New Contact.

2. Use the New Contact page to enter information about the contact, and then click Save Contact Information.
Importing Contacts

You can import multiple contacts into the list from a comma separated values (.csv) file. E-mail applications that create a .csv file include Outlook, Gmail, Hotmail, and Yahoo Mail; for other applications you may first need to create a .cvs file. **Contacts can not be exported.**

1. From the left panel, click **Import Contacts**.

2. Click **Choose File** and use the resulting dialog box to locate and select the .csv file.
3. Click **Upload**.

**Editing a Contact**

1. From the list, click on the name of the contact you want to edit. Details displayed are Contact Information. From this page, you can also **Delete Contact** and **Send an Email** to the contact.

2. Click **Edit Contact**.
3. Use the Edit Contact page to change information about the contact, and then click **Save Contact Information**.

**Deleting a Contact**

- From the My Contacts list, click on **X** associated with the contact you want to delete.
- You can also delete a contact as part of the process of **editing a contact**.
How to Import and Export Contacts

Contacts from your e-mail application can be exported to a comma separate values (.csv) file, which can then be used to import those contacts into your Pulse Contacts list. E-mail applications that create a .csv file include Outlook, Gmail, Yahoo Mail, and Hotmail. For all other applications, you may first need to create a .cvs file.

Creating a CSV File from Outlook

1. From Outlook, choose File > Options > Advanced.
2. In the Export section, click Export.

3. In the Import and Export Wizard, choose Export to a file, and then click Next.

4. Under Create a file of type, click Comma Separated Values, and then click Next.
5. Under Select the folder to export from, select the contact folder you want to export, and then click Next.
   You can export only one folder at a time.
6. Under Save exported file as, click Browse, choose the folder where you want the file saved and type a name in the File name box.
7. Click OK, and then click Next.
   You have the option to map fields for your contacts.
   Click Finish. When the Import and Export Progress box disappears, your export is complete.

Creating a CSV File from Gmail

1. From Gmail, choose Contacts from the drop-down menu at the top-left corner of your Gmail page.

2. From the More drop-down menu, select Export.
3. Choose whether to export all contacts or only one group.
4. Select the Outlook CSV format.
5. Click Export.
6. Choose Save to Disk then click OK.
7. Select a location to save your file, and click OK.

Creating a CSV File from Yahoo Mail

1. From Yahoo Mail, click the Contacts icon in the left navigation column.
2. Select Actions | Export.

3. Select Yahoo CSV.
4. Click Export Now.

Creating a CSV File from Hotmail

...
1. From Hotmail, click the **down-arrow** at the upper-left corner of your screen.
2. Choose **People**.
3. Click **Manage** in the menu bar.
4. Choose **Export**
5. Save the file to your desktop.

### Creating a CSV File for Other Applications

1. Using Microsoft Excel, add the following heading (i.e., in Row 1) to the Excel file:

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>First Name</td>
<td>Last Name</td>
<td>Business Street</td>
<td>Business Street 2</td>
<td>Business City</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. Enter your contact information below each heading.

<p>| | | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>Jane Doe</td>
<td>111 Main Street Suite 3</td>
<td>San Francisco</td>
<td>CA</td>
<td>94108</td>
</tr>
</tbody>
</table>

3. From the **File** menu, choose **Save As**.
4. Using the **Save As** dialog box, enter a **File name** and choose **CSV (Comma delimited)** from the **Save as type** drop-down menu.
5. Click **Save**.
Communicating with Your Business (EComms)

Available to Pulse Pro subscribers only

The EComms tab provides access to your Pulse e-mail account. As a Pulse Pro subscriber, you automatically receive a Rodan + Fields e-mail address. Your Pulse e-mail address is the first part of your PWS URL combined with @myrandf.com. For example, if your .biz PWS URL is http://janedoe.myrandf.biz, then your Rodan + Fields e-mail address would be janedoe@myrandf.com.

Note that you can only access your Pulse e-mail online through Pulse; these e-mails can’t be automatically forwarded to another account. However, you can manually forward your e-mail, by addressing and sending each e-mail to another account.

There is no functionality for creating Pulse e-mail distribution lists; instead you can e-mail all, or a subset of individuals, from various reports and contact lists.

Using the EComms tab, you can:

- Compose a new message
- Read a message
- Work with a message
Available to Pulse Pro subscribers only

You can compose and send an e-mail from some reports and contact lists. Rodan + Fields provides a library of branded e-mail templates for your convenience.

Before composing a message, you may want to create an e-mail signature.

1. Then from the left panel, click Compose a New Message.

2. Use the Compose a New Message page to address and write your e-mail. If you have created an e-mail signature, it is automatically added in the message body.

3. To attach a file to an e-mail, click Attach from my computer. Use the resulting dialog box to locate and select the file.

4. If you want to use a Rodan + Fields e-mail template, click Use an Email Template. From the resulting page, choose the template from the drop-down menu and then click Use This Template.
The template text is automatically included in the body field of the **Compose a New Message** page.

5. To save the message as a draft, click **Save**.

6. When you are ready to send the message, click **Send Message**.
Reading a Message

Available to Pulse Pro subscribers only

Message are organized in various categories.

1. From the left panel, under the Mailboxes heading, click the category in which the e-mail you want to read resides.

The list of e-mails in that category is displayed.

2. You can narrow the list of messages by entering an e-mail's sender name (first or last name) in the Search for From field. Then click Search.

   Note: An e-mail list displays information based on the Search for From field until you choose to either remove the filter by clicking Clear Searches & Filters, or select a different tab, or close the current Pulse session.

3. From the list, select the e-mail you want to read.

   The e-mail is displayed.
Working with Messages

Available to Pulse Pro subscribers only

From the EComms tab, you can reply to, forward and delete a message.

1. Select and open the message from your Pulse e-mail account with which you want to work. The e-mail is displayed.
2. To Reply or Forward the e-mail, click the appropriate link.
3. Use the Compose a New Message page to address and write your e-mail.
4. If you want to delete the e-mail, click Delete. You are asked to confirm this action.
Creating Custom Communications (Comms Corner)

Available to US Consultants only

The Communications Corner website (http://communications.rodanandfields.com) can help you drive sales by creating custom marketing tools for your R+F business.

To use the Communications Corner, from your Pulse Dashboard, click the Comms Corner shortcut. The Communications Corner website opens in a new browser window.

You may want to create an e-mail signature that you can add to all your custom marketing tools.

For information on creating and sharing custom marketing materials, refer to the Communications Corner How-To Guide.
Order History (Orders)

Use the Orders tab to see all orders for a selected period that impacts your SV and PSQV. This includes your personal orders, and orders placed by your Retail Customers, Preferred Customers, and your Level 1 Consultants and their Retail Customers. Note that:

- Personally placed and retail orders are shown as SV.
- Personally Sponsored Level 1 order volumes are counted as PSQV.
- Level 1 order volumes not personally sponsored have no PSQV value.
- The original order number associated with a return is shown in parenthesis in the Order Type column.
- Negative volumes associated with a return are shown for Orders Purchased and Returned in the same commission period.

Order history is updated in real-time. If you don't see your order in Pulse right away, try refreshing the page after a few minutes.

An order has a **Failed** status when there is a problem with an individual's credit card on file. **Contact the individual** to help them resolve the issue.

Pending and off-month autoship orders can be viewed from the **Autoship CRP/Pulse report** and the **Autoship PC Perks** report.

Your order **shipping and billing profiles can be changed and managed**. However, note that changing your default profiles does **not** automatically update your existing autoship cart. If you want your **existing** autoship to use the new default address, edit your **CRP subscription** or **Pulse subscription** with the new address. All new orders will use the updated default profiles.
How to Review Orders on Pulse

You can view all orders for a selected period and how those orders impact your SV and PSQV. This includes your personal orders, and orders placed by your Retail Customers, Preferred Customers, and your Level 1 Consultants and their Retail Customers. Once you know the products a Customer has ordered in the past, you can tailor follow-up e-mails and phone calls accordingly.

1. From Pulse, click the **Orders** tab.

![Orders tab](image)

2. Specify the report's options. The full set of options are available by clicking **View More Filter Options**.
   
   **Note**: The Order History displays the information based on your options until you choose to either remove all filters by clicking **Clear Searches & Filters**, or select a different tab, or close the current Pulse session.

   ![Order History filters](image)

   These options are:
   - **Search for Name**: Name of the Customer on which you want information.
   - **Period**: Compensation period of interest.
   - **Search for Country**: Country of origin of the order.
   - **Date**: Date range of interest.
   - **SV**: SV range of interest.
   - **PSQV**: PSQV range of interest.

3. Click **Run Report**.

![Run Report](image)

4. If you want to reorder the data by **Commission Date** in either ascending or descending order, click on that column's heading.

![Commission Date](image)

5. To view the details of an order, click **View Details** under the Order column. Details on an individual's orders, and tracking and shipping information, is shown.

6. You can put the data in an Excel spreadsheet by clicking **Export to Excel**.

![Export to Excel](image)
How to Check for Failed CRP Orders

Failed CRP orders usually indicate that there is a problem with an individual’s credit card on file. You can check for failed CRP orders using the Autoship CRP/Pulse report:

1. Open the Autoship report.
2. Click on the CRP/Pulse tab.
3. From the View More Filter Options > CRP Status drop-down menu, choose Failed.

![CRP Status: Failed]

You can narrow the report results further by specifying additional options.


<table>
<thead>
<tr>
<th>Level</th>
<th>CRP Enrollment Date</th>
<th>CRP Date</th>
<th>CRP Status</th>
<th>CRP QV</th>
<th>Pulse Enrollment Date</th>
<th>Pulse Date</th>
<th>Pulse Status</th>
<th>Pulse QV</th>
<th>SV</th>
<th>PSQV</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>05/21/2014</td>
<td>10/28/2014</td>
<td>Failed</td>
<td>100</td>
<td>05/21/2014</td>
<td>10/28/2014</td>
<td>Processed</td>
<td>20</td>
<td>20</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>09/05/2013</td>
<td>10/10/2014</td>
<td>Failed</td>
<td>145</td>
<td>09/05/2013</td>
<td>10/10/2014</td>
<td>Processed</td>
<td>20</td>
<td>20</td>
<td>878</td>
</tr>
<tr>
<td>3</td>
<td>05/15/2014</td>
<td>10/22/2014</td>
<td>Failed</td>
<td>94</td>
<td>05/15/2014</td>
<td>10/15/2014</td>
<td>Processed</td>
<td>20</td>
<td>20</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>04/22/2014</td>
<td>10/28/2014</td>
<td>Failed</td>
<td>90</td>
<td>04/22/2014</td>
<td>10/28/2014</td>
<td>Failed</td>
<td>20</td>
<td>0</td>
<td>75</td>
</tr>
<tr>
<td>3</td>
<td>09/07/2012</td>
<td>10/13/2014</td>
<td>Failed</td>
<td>92</td>
<td>09/07/2012</td>
<td>10/13/2014</td>
<td>Failed</td>
<td>20</td>
<td>0</td>
<td>77</td>
</tr>
<tr>
<td>3</td>
<td>03/19/2014</td>
<td>10/24/2014</td>
<td>Failed</td>
<td>238</td>
<td>03/19/2014</td>
<td>10/19/2014</td>
<td>Processed</td>
<td>20</td>
<td>20</td>
<td>218</td>
</tr>
<tr>
<td>3</td>
<td>08/06/2014</td>
<td>10/13/2014</td>
<td>Failed</td>
<td>105</td>
<td>08/06/2014</td>
<td>10/13/2014</td>
<td>Failed</td>
<td>20</td>
<td>45</td>
<td>205</td>
</tr>
<tr>
<td>3</td>
<td>07/02/2014</td>
<td>10/07/2014</td>
<td>Failed</td>
<td>90</td>
<td>07/02/2014</td>
<td>10/07/2014</td>
<td>Failed</td>
<td>20</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>12/10/2013</td>
<td>10/15/2014</td>
<td>Failed</td>
<td>169</td>
<td>12/10/2013</td>
<td>10/15/2014</td>
<td>Failed</td>
<td>20</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>01/29/2014</td>
<td>10/28/2014</td>
<td>Failed</td>
<td>145</td>
<td>01/29/2014</td>
<td>10/21/2014</td>
<td>Failed</td>
<td>20</td>
<td>0</td>
<td>569</td>
</tr>
<tr>
<td>3</td>
<td>09/14/2014</td>
<td>10/28/2014</td>
<td>Failed</td>
<td>83</td>
<td>11/26/2012</td>
<td>10/28/2014</td>
<td>Failed</td>
<td>20</td>
<td>0</td>
<td>315</td>
</tr>
<tr>
<td>3</td>
<td>09/24/2014</td>
<td>10/28/2014</td>
<td>Failed</td>
<td>105</td>
<td>08/16/2014</td>
<td>10/28/2014</td>
<td>Failed</td>
<td>20</td>
<td>0</td>
<td>495</td>
</tr>
<tr>
<td>PSL1</td>
<td>01/21/2014</td>
<td>10/28/2014</td>
<td>Failed</td>
<td>90</td>
<td>01/27/2011</td>
<td>10/20/2014</td>
<td>Processed</td>
<td>20</td>
<td>20</td>
<td>2,575</td>
</tr>
</tbody>
</table>

5. If you want to send an email to those individuals with a failed autoship, click the appropriate e-mail option (Email Selected On Page or Email All in This Report).
How to Check for Failed PC Perks Replenishment Orders

Failed PC Perks orders usually indicate that there is a problem with an individual's credit card on file. You can check for failed PC Perks orders using the Autoship PC Perks report:

1. Open the Autoship report.
2. Click on the PC Perks tab.
3. From the View More Filter Options > PC Perks Status drop-down menu, choose Failed.

![PC Perks Status: Failed](image)

You can narrow the report results further by using additional filters.


<table>
<thead>
<tr>
<th>PC Perks Enrollment Date</th>
<th>PC Perks Date</th>
<th>PC Perks Status</th>
<th>QV</th>
</tr>
</thead>
<tbody>
<tr>
<td>01/04/2010</td>
<td>11/04/2014</td>
<td>Off Month</td>
<td>75</td>
</tr>
<tr>
<td>02/15/2010</td>
<td>10/15/2014</td>
<td>Processed</td>
<td>78</td>
</tr>
<tr>
<td>03/13/2010</td>
<td>11/07/2014</td>
<td>Off Month</td>
<td>79</td>
</tr>
<tr>
<td>05/03/2010</td>
<td>11/03/2014</td>
<td>Off Month</td>
<td>100</td>
</tr>
<tr>
<td>06/17/2010</td>
<td>10/17/2014</td>
<td>Processed</td>
<td>135</td>
</tr>
<tr>
<td>11/21/2010</td>
<td>11/20/2014</td>
<td>Off Month</td>
<td>145</td>
</tr>
<tr>
<td>03/03/2011</td>
<td>10/03/2014</td>
<td>Processed</td>
<td>145</td>
</tr>
<tr>
<td>03/26/2011</td>
<td>10/21/2014</td>
<td>Processed</td>
<td>302</td>
</tr>
</tbody>
</table>

5. If you want to send an e-mail to those individuals with a failed autoship, click the appropriate e-mail option (Email Selected On Page or Email All in This Report).
R+F Events

You can keep track of upcoming and future R+F company events, and register for an event, from the Events tab. The start time of an event is the local time of that event's location, and not the time of the location from which you access Pulse.

Note that with this version of Pulse, you can't synchronize your events with your mobile phone.

Upcoming Events

The five next upcoming events are listed in the Upcoming Events area of your Dashboard. Clicking on an event in the list displays details on, and allows you to register for, that event.

Upcoming Events
07/10/2014 6:30 PM EST  
Market Expansion Celebration - New Orleans, LA
07/11/2014 6:30 PM EST  
Business Presentation - Charlotte, NC
07/11/2014 6:30 PM CST  
Business Presentation - Franklin, TN
07/12/2014 8:30 AM CST  
Market Expansion Series Module 2 - Franklin, TN
07/12/2014 8:30 AM EST  
Groundswell Series Part 2 - Charlotte, NC

Go to R+F Calendar

Future Events

All events, including future events, are displayed on the R+F Calendar. You view this calendar by clicking either the Go to R+F Calendar link in the Upcoming Events section, or the Events tab.

You can narrow the events shown in the calendar, by selecting the country of interest from the Show events in drop-down menu and clicking Apply Filter.

Clicking on an event in the calendar displays details on the event. To register for the event, click Click Here to register.
business presentation – denver, co

Start: 6/4/2014 6:30 PM
End: 6/4/2014 8:00 PM
Mountain Standard Time

Featuring Regional Director of Field Development Meredith Tieszen

6:30 p.m. – Registration
7:00 p.m. – Business Presentation

Columbine Country Club
17 Fairway Lane
Littleton, CO 80128

Consultants: $10.00
Admission is free for Guests

Click here to register
Managing Your Account (My Account)

Using the My Account tab, you can manage your R+F account, including:

- Editing your personal information and address of record
- Updating your shipping and billing profiles
- Changing your security settings
- Editing your CRP order
- Editing your Pulse subscription
- Editing your PWS
Editing Personal (Contact) Information

Any updates you make in your personal information and address is reflected in your PWS.

1. From the left panel, click **Account Overview**.

![Account Overview](image)

The My Account Overview page is displayed. Your **Birthday** and **Spouse Name** are not required. The **Enrollment Date**, **Next Renewal Date** and **EC Anniversary** are automatically populated and cannot be edited. If this information is incorrect, contact Sales Support at 1-415-273-8000 during published business hours.

2. Click **Edit** under **My Primary Account Record**.

![Edit My Account](image)

3. Use the Edit My Account page to make the changes you want, and then click **Save Personal Information**.

The **Address of Record** is the address to which all company communications, tax forms and monthly commission checks are sent, and is also the address shown in a **Contacts list**.
Updating Shipping and Billing Profiles

Updating billing and shipping profiles involves adding a new profile, editing an existing profile, making a profile the default, and deleting a profile.

**Note:** Changing your default shipping or billing profiles does **not** automatically update your existing autoship cart. If you want your existing autoship to use the new default address, edit your **CRP subscription** or **Pulse subscription** with the new address. All new orders do use the updated default profiles.

1. From the left panel, click **Account Overview**.

   ![](https://example.com/image1)

   The My Account Overview page is displayed.

2. If you want to add a new profile, click **Add New Profile** under the type of profile you want to add.

   ![](https://example.com/image2)

   Use the New Profile page to specify the profile and then click **Save Profile Changes**.

3. To edit the default profile, click the pencil icon associated with that profile.
If you want to edit another profile, select that profile from the My Other Profiles list associated with the type of profile you want to edit.

Use the Edit Profile page to make your changes, and then click **Save Profile Changes**.

4. You can specify the default profile by, from the Edit Profile page for that profile, clicking **Make Profile Default**.

5. If you want to delete a profile, from the Edit Profile page for that profile, click **Delete This Profile**.
Changing Your Security Settings (Username and Password)

You can change your username and password in Pulse at anytime. Passwords are updated immediately.

Note that your Pulse, PWS and Corporate website username and password are the same. So if you change your username and password in Pulse, you must use those credentials when logging in to your PWS or the Corporate website.

1. From Pulse, click the My Account tab.
2. Click Change My Security Settings from the left panel.
3. Use the My Security Setting Page to enter a new username and/or password.
4. Click Save Security Settings.
Editing Your CRP Order

The Consultant Replenishment Program (CRP) provides you with the convenience and benefits of a regular monthly shipment of R+F products. From the Pulse My Account tab, you can change the contents of your CRP cart, update billing and shipping information and cancel your CRP subscription.

1. From the left panel, click Edit My CRP.

   ![Edit My CRP](image)

   You can also, from the My Account Overview page, click Edit from the CRP section.

2. To change the contents of your CRP autoship, from the Replenishment page click Order Items on the top of the page or Edit Replenishment Order at the bottom. Next use the Order page to add to or delete items from your autoship, and then click Update Order.

3. If you want to update your CRP shipping information, click Change in the Shipping section of the page.

   ![Shipping to](image)

   Use the resulting page to specify a new shipping address, change the default address, or delete an address.

4. When you want to update your billing information, click Change in the Billing section of the page. Then use the resulting page to specify a new billing address, change the default address, or delete an address.

5. If you want to cancel your CRP subscription, at the bottom of the Replenishment page, click the deactivate link.
Editing Your Pulse Subscription

A Pulse Pro subscription gives you access to the full functionality of Pulse. From the My Account tab, you can subscribe to Pulse and edit your billing information.

To cancel Pulse, contact Sales Support at (415) 273-8000.

1. From the left panel, click **Edit My Pulse Subscription**.

You can also, from the My Account Overview page, click **Edit** from the Pulse Subscription section.

![](image)

The Subscription page opens in a new browser window. **Note**: If the Subscription page doesn't open, make sure your pop-up blockers are disabled.

2. If you do not have a Pulse Pro subscription, you are presented with the information and the ability to enroll.

3. To update your billing information, click **Change** in the Billing section of the page. Then use the resulting page to specify a new billing address, change the default address, or delete an address.
Available to Pulse Pro subscribers only

As an R+F consultant, you received two Personal Web Sites (PWS): .com PWS and .biz PWS. Both these websites can be personalized with a profile that includes your photo, contact information, story, best business moment and favorite R+F products. You can edit your profile from either Pulse or from your PWS.

1. From the Pulse My Account tab, click **Edit My PWS**.

   ![Pulse My Account tab](image)

   From your PWS, login and then click **Edit My PWS**.

   The Editing PWS page opens in a new browser window.

   **Note:** If the Editing PWS page doesn't open, make sure your **pop-up blockers are disabled**.

2. In the appropriate section of the page, click **Edit** to change that information.

   The resulting page provides information on making that change.
Getting Answers to Skincare Questions (RF Connection)

When presented with skincare questions from your Customers or downline, turn to the RF Connection micro-site (http://www.rodanandfields.com/rfconnection). Answers are organized by General Questions, Ingredients, Products, and Health Concerns.

To access RF Connection from your Pulse Dashboard, click the RF Connection Micro-Site shortcut. The RF Connection micro-site opens in a new browser window.

Note: If RF Connection doesn't open, make sure your pop-up blockers are disabled.

Information on using RF Connection is available from the Home page of the micro-site. Also refer to the RF Connection Tips.
Purchasing R+F-Branded Collateral (RF Mall)

The RF Mall website is the location for purchasing R+F-branded collateral for use in your business, including business cards, brochures, event flyers and more.

To use the RF Mall from your Pulse Dashboard, click the RF Mall shortcut. The RF Mall website opens in a new browser window.

Note: If the RF Mall website doesn't open, make sure your pop-up blockers are disabled.

Refer to the RF Mall FAQs for more information.
Using the R+F Virtual Wallet (RF Payday)

Available to Pulse Pro subscribers only

Available to US Consultants only

RF Payday is an easy-to-use, secure, online virtual wallet offered exclusively to Rodan + Fields Consultants. Using RF Payday, you can receive commission payments electronically, and quickly and efficiently send funds to a personal bank account, a branded R+F Visa Prepaid Card, or request a check.

To use RF Payday from your Pulse Dashboard, click the RF Payday shortcut. The RF Payday website opens in a new browser window.

Note: If the RF Payday website doesn't open, make sure your pop-up blockers are disabled.

Refer to the RF Payday FAQ and RF Payday Terms and Conditions for information on using the RF Payday website.
Leading the Way

The Lead the Way site (https://www.rodanandfields.com/leadtheway) helps you reach your business milestones, earn rewards and celebrate your successes.

To access the Lead the Way site from your Pulse Dashboard, click the **Lead the Way** shortcut. The Lead the Way website opens in a new browser window.

**Note:** If the Lead the Way website doesn’t open, make sure your **pop-up blockers are** **disabled**.

Refer to the *Lead the Way FAQ*, *Lead the Way guide*, and *Lead the Way Terms and Conditions* for information on using the Lead the Way website.
Cancelling Your Pulse Subscription

You can cancel your Pulse subscription at any time, and instead conduct your R+F business using the company site (www.rodanandfields.com) to enroll downline Consultants and sell product online. However when using the company site, downline Consultants and Customers must log in and identify you as their sponsoring Consultant, so that sales and enrollments are attributed to your account.

To cancel Pulse, contact Sales Support at (415) 273-8000.
Troubleshooting Pulse

As you use Pulse, you may need to address the following issues:

- Disabling pop-up blockers
- Allowing others to use your Pulse account
- Pulse running slowly
- Data not updating
How to Disable Pop-up Blockers

Pulse uses pop-ups to communicate various messages and display reports. Your Internet provider and/or browser may, by default, block these pop-ups. In order to optimize your Pulse experience, you should disable these pop-up blockers (for Pulse only).

Depending on what is installed on your computer, it is possible that you may have more than one pop-up blocker running. You must disable all pop-up blockers for Pulse to work properly.

If your pop-up blocking software is not listed here, check along the bottom right corner of your screen, as most pop-up blockers are installed either within the browser toolbar or within the Windows taskbar.

Explained here is information about disabling pop-up blockers for:

- Internet Explorer
- Google Chrome
- Yahoo
- Safari (Mac)
- AOL
- MSN

For all other browsers, applications or firewall software, refer to your software's documentation.

Internet Explorer

Pop-up blocking is integrated into Internet Explorer. To disable the Internet Explorer pop-up blocker:

1. From the Tools menu choose Internet Options.
2. Click the Privacy tab.
3. Uncheck Turn on Pop-up Blocker, and then click OK.

Google Chrome

Google Chrome prevents pop-ups from automatically appearing and cluttering your screen. Whenever the browser blocks pop-ups for a site, the icon appears in the address bar. To disable Google Chrome pop-up blocking:
1. Click the icon in the address list to see a list of the blocked pop-ups.
2. Select **Always show pop-ups from [site]**. The Pulse website is added to the browser’s exceptions list.

### Yahoo

The Yahoo toolbar is available as part of Yahoo’s service. To disable the Yahoo pop-up blocker:

1. Click **Pop-Up Blocker** on the Yahoo toolbar.

2. Using the drop-down menu, select **Enable Pop-up Blocker** to uncheck the option.

### Safari (Mac)

To enable pop-ups when using Safari:

- From the **Safari** menu, make sure **Block Pop-Up Windows** is unchecked.

### AOL

The AOL toolbar adds pop-up blocking functionality to your Internet Explorer software. To enable AOL pop-ups:

1. On the AOL toolbar, click **Blocking Pop-ups**.
2. Click **Turn Pop-up Controls Off**. The **Pop-Up Blocker** icon displays a green light symbol.
To enable pop-ups when using MSN:

1. From the MSN toolbar, click **Pop-ups Blocked**.

2. Choose **Allow Pop-ups** from the drop-down menu.
Allowing Others to Use Your Pulse Account

More than one person can access Pulse using the same account, at the same time. However, only one person at a time can make changes to the account.

If you are sharing your Pulse account with another person, please be advised that Pulse contains privacy sensitive information, including your billing information.
Pulse Running Slowly

There are many reasons that cause a computer to run slowly, including your computer itself, the operating system or other software, and the Internet connection or the Internet service provider.

Pulse may also be running slowly because of the amount of data that needs to be loaded into your reports.

If you have checked and there are not problems with your home computer setup, contact other Consultants to see if they are having similar problems. If so, then contact Sales Support at (415) 273-8000.
Data Not Updating

Most data in Pulse is updated in near real time. However there may be some server delays in updating your information, such as a newly placed order or on high volume days like month end.

To ensure that you are viewing the most up-to-date data, refresh your web page.